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Podcasting involves the creation and distribution of multimedia files, such as audio files
(most commonly, MP3s) or videos, over the internet for playback on mobile devices and
personal computers. The term podcast, like 'radio’, can mean both the content and the
method of delivery. Podcasts are already being used by savvy universities for marketing and
recruitment. Some universities use podcasts to providing expert commentaries on topical
issues from researchers or staff who are renowned authorities on their subject. They can be
used to share the latest outcome of a research project. The advantage of podcasting is the
relative ease at which it is possible to create recordings and distribute them via the
internet.

Teaching a course with podcasting provides an additional way to share lecture content and
promote student engagement. Podcasts can be made by simply recording a seminar/lecture
or by creating them de novo as an additional learning resource. Educational video and
audio is undergoing a step change, posing new requirements on institutional workflows that
have high overlap between institutions. Particularly the availability of affordable recording
techniques as well as new distribution channels has changed the way in which audio and
video visual material is used in UK higher education. As downloadable audio and video,
podcasts empower an educator with the ability to deliver course materials and lectures
outside a conventional classroom environment. Students, or interested parties (depending
on whether the material is publicly available) can access the material from outside the
campus, view it at any time, and by downloading it to a portable media device (such as an
iPod) can view the material anywhere.

Academic commentary, interviews, or public lecture series could also be published as a
podcast and made available publicly or to a restricted audience (using the institutions
single-sign-on system). Podcasting technology is useful for regular commentary because
RSS listing allows users to subscribe to the podcast feed; being alerted and downloading
the latest instance in the series. Linking to a podcast directory allows you to find new
material quickly. The most popular directory service is the one provided by the Apple
iTunes software, which is a free download from Apple (11" iTunes can search existing
podcasts based on outputted RSS feeds, and fully integrate academic podcast series into
Apple’s own service, iTunes U (www.apple.com/itunesu [2]), which academic institutions
must sign-up to prior to use.

“Podcasts are different from Internet radio stations. Radio content is streamed over the

Internet. Podcast episodes are downloaded to your computer and you can copy them to an
iPod (or other media player)”



http://www.apple.com/itunesu/
http://www.apple.com/itunes/
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A particular advantage to podcasting is that the media is easily created by most recording
equipment (an iPod with a mic, a computer, a DV camera &c.) and is encoded into an
industry standard (MP3) that is universally read by computers and portable media devices.

Widening one's perspective, podcasts can be published by students and made available in
exactly the same manner as their academic counterparts. Student podcasts could document
the learning experience, the development of their knowledge, experimental / research
methods or simple commentary of any nature. Apple’s iTunes U has a built-in feature that
allows students to upload podcasts which can be viewed either by the tutor or by fellow
students (suitable for peer review).

We want *YOU* to contribute

This booklet is not a polished guide. It is not perfect nor is it complete. We have taken a
snapshot of the information in the Steeple project's wiki and made it available as an
example of what podcasting involves. The printed document contains only a fraction of what
we have online at the Steeple project wiki [3] The wiki is a live and expanding guide to the
issues surrounding academic and institutional podcasting. We encourage you to visit the
Steeple website and contribute your expertise, thoughts, concerns and questions.

This booklet and its online wiki companion is released under a Creative Commons
Attribution-Noncommercial-Share Alike [*! license. You are free to photocopy and distribute
any portion of it as long as it's for non-commercial use. You are free to re-use and re-mix, as
long as you share the result under the same (or a compatible) license.

About Steeple

Steeple 51 is a JISC (6] funded UK Higher Education community project, led by Oxford
University [7], the Open University [8], and Cambridge University (31 The vision for the
Steeple project is to create a viable community around scalable, enterprise-level solutions
suitable for the UK higher education sector in the areas of automated video/audio capture,
video/audio processing, and video/audio delivery ("podcasting").

The Steeple project will look at the processes supporting effective use of audio and video
podcasts using emergent technologies that can streamline complex audio-visual encoding
activities through enterprise level services. This centralised institutional work will relieve
the burden placed on departmental support structures and lead to long term savings from
the reduced time and effort in creating audio visual materials for teaching, research and
outreach. The project will run from October 2008 to March 2010. We are hoping to work
with all UK higher education institutions that have an interest in OpenCast [10], and hope
that Steeple will lead to strong participation of UK-HEI in OpenCast.

The rest of this page is intentionally left blank for your own contributions! Please

contribute to these tutorials by visiting Steeple at http://www. steeple. org. uk/
contribute"



http://www.steeple.org.uk/contribute''
http://www.steeple.org.uk/wiki/Main_Page
http://creativecommons.org/licenses/by-nc-sa/3.0/
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The prime motivator for the use of podcasts within a course should be the achievement of
the learning outcomes or specific objectives of a learning activity. A review of the current
course structure and pedagogy will allow strengths and weaknesses to be identified. As a
tutor you may wish to address a weakness with the introduction of podcasts. By addressing
the questions on the pedagogical and technical issues and relating these to learning theory
the tutor will be in a much stronger position to assess whether the introduction of podcasts
will help achieve the learning outcomes or objectives (http://www.bioscience.heacademy.
ac.uk/resources/projects/barry.aspx).

Podcasting Activities

TUTOR INITIATED PODCASTS STUDENT INITIATED PODCASTS

Entire lectures Reflections on an activity

Visiting lecturer Summary of key idea/theory

Pre lecture material Discussion between two or more students of a

pertinent issue/idea/theory

Seminar discussion Assignment work - presentation, field report or
project

Supplementary topics that you may not have time to cover in Interview a specialist in a specific field
the lecture

Supplementary topics explaining difficult/complex areas of  Interview other students
course

Authentic audio materials Podcast to encourage peer evaluation
Feedback to students on assignments

Summary of journal articles on a research topic

Record interviews with specialists in a specific field

Provide information for field trip activities

Provide administrative information

Interactive podcasts with tasks/questions and links to URL
sites

Provide pronunciation of technical language or relevant
sounds (e.g. Korotkoff sounds when measuring blood
pressure)



http://www.bioscience.heacademy.ac.uk/resources/projects/barry.aspx
http://www.bioscience.heacademy.ac.uk/resources/projects/barry.aspx
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The Podcasting Process

The means by which podcasts are created and released is simplified to three common steps:

¢ Capture: The content itself needs to be recorded and digitised. This could be via a simple
audio recorder through to a professional film crew.

e Process: These files may need some editing work to improve quality, and then will need
compressing into the smallest suitable file format.

¢ Publish: These smaller files are then placed on a public web server and details about the
content is added to a subscription system that supports RSS and podcasts.

Styles of podcasting

It is worth considering who your intended audience is when preparing to podcast, and also
the style in which you wish to present your content. Whilst audio only recordings are much
easier to do from a technical standpoint, the material being talked about needs to be easy
to understand without visual references. Lecture recording is good as a reference aide for
current students, but viewed out of context by someone from an unrelated field may prove
difficult for them to understand. Screencasts - where a video is produced of a slideshow
with a narrated soundtrack - are popular ways to provide helpful visual references without
requiring camera work and allows the presenter to remain unseen whilst delivering an
engaging talk.
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Files, formats and sizes

Audio - is the most common form of podcast content. Files are encoded/compressed using
the MP3 algorithm and typically produce hourlong recordings in files of 60Mb or under. For
audio recordings where extra quality is required (e.g. music performances), larger file sizes
with higher quality settings can be used.

Video - is often the more popular format for podcasts and offers a variety of uses ranging
from camera footage of a performance, to captured slide presentations, to images/photos
akin to a slide show. The format used is called MP4, and utilises the H264 video codec to
compress the visual data. Typical outputs will be 640 pixels wide, in either a 4:3 or 16:9
(widescreen) aspect ratio, and use 700kbps of data, resulting in an hour’s video producing a
file size of 350Mb.

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http:// www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=8149

Contributors: Bjoern, OLewis, PeterRobinson
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When creating or distributing a podcast, it is important to make sure all necessary rights
and permissions are secured for the material included in the podcasts. This is relatively
easy if you create all of the material that is included in the podcast but can become
progressively more complex the more you include material created by other people. In
education this can be as simple as asking the lecturer to sign a release form and need not
be unnecessarily complicated with professional film or television copyright forms.
Nonetheless, if you do not obtain the necessary rights and permissions you may get into
legal trouble for incorporating third party material into your podcast and for authorising
others to use that material as part of your podcast.

For the purpose of audio recording a talk, the relevant rights fall into three broad
categories:

1. Speakers own what they say (their 'performance') and so a release form is needed to
give the rights to this to the institution.

2. The recordist also has rights to their recording (the 'physical' recording) and so needs
to sign a release form.

3. However, other 'works' also have copyrights attached to them, for example songs,
pictures, books, lectures, slides (third party copyright). Permissions from third parties is
hard to clear, and so:

1. During the talk, you cannot play commercial music from CD, read poetry, or play
commercial videos without running into copyright issues. However, you can read short
extracts from books and articles.

Consequently a basic plan of action could be to:

1. Ask the speaker - well in advance of the talk - if you can record their talk and distribute
it over the internet.

2. Ensure the speaker signs a release form.

3. Ask if the speaker plans to use poetry, music or video, and if so seriously consider if
recording and subsequent distribution is likely to be possible.

4. Secure the permission of the recordist, who should also sign a release form.

You should note that the speaker may not be able to negotiate their own rights: For
instance, if the speaker appears on behalf of an organisation, or the contract is being dealt
with by the speakers agency. In these examples, we assume that the speaker can deal with
their own rights, which often is the case for academic talks. However, depending on the
home institution of the speaker, some of their work may be owned by their institution.
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Permissions

A conversation (by email or otherwise) with a potential lecturer might go like this:

* Organiser: "We were hoping you might be able to give a talk for us as part of our
upcoming series on XYZ."

e Lecturer: "That sounds great. I would be happy to do this."

* Organiser: "By the way, to increase the impact of our talks, and to promote our cause as
broadly as possible, we do what many organisations now do: We record all our talks, and
put them online. Is this fine with you?"

e Lecturer: "Yes, that's okay."

* Organiser: "I'll email you a release form, and it would be great if you could sign it and
post it back. Otherwise we can have one for you on the night."

e Lecturer: "That's good, I'll get that back to you straight away."

* Organiser: "When we do the recording, we have to make sure that we comply with
copyright legislation. Could I double check whether you are planning to play any music,
DVDs, or film during the talk, or whether you are planning to recite some poetry?"

* Lecturer: "Nope, no poetry, music or DVDs of any kind."

¢ Organiser: "Great, thanks!"

This is your best outcome and it means you can just go ahead and record/publish the talk
without any issues.

If you are new to podcasting, there are a lot of issues you will have to think about, including
technical, editorial, publishing and so on. You should try to keep things as simple as
possible to make sure that you can go through all the required processes without getting
stuck and to make sure that you see some fruits of your labour quickly. So if you have a
choice over which talks to record pick some talks that are straight forward to record and
where permissions are simple. Once you have a good overview and experience of the entire
podcasting process you can move on to recording more complicated talks. We say this from
experience: Where people try to "bite off too much", they get stuck and do not produce any
output. This in turn leads to frustration and the view that it "cannot be done". So start with
some easy talks!

Getting permission with "non-commercial” third party
rights

A variant of the previous conversation, this time there are music and DVDs used, but they
are not commercial:

* Organiser: "When we do the recording, we have to make sure that we comply with
copyright legislation. Could I double check whether you are planning to play any music,
DVDs, or film during the talk, or whether you are planning to recite some poetry?"

e Lecturer: "Ah, actually I have rather a lot of music and film."

¢ Organiser: "What sort of film and music do you have? Is it commercial, or your own?"

e Lecturer: "Nothing bought, it's all my own. The film is field-work footage from our trip to
Antarctica."

* Organiser: "Do you know who owns the rights?"

1. The conversation can now go several ways. Best case:

* Lecturer: "We release all our materials under creative commons license, so as long
as you comply with this, there are no problems."
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* Organiser: "Could you get us a list of items, and associated licenses?"
e Lecturer: "No problem, it's all on my last slide anyway, so you can just copy it from
there."
2. But more likely:

* Lecturer: "It was all taken by me personally, and I do happen to know that at our
institution, professors own their materials. Some of it was taken by a technician, so
it would be owned by our institution, but as principal investigator on the project, I do
know that the institution is happy for me to give you permission to use this."

* Organiser: "As long as you are happy for the sound track of your films are
reproduced in the audio recording, that's all fine. Would you be happy to get us the
relevant permissions in writing?"

* Lecturer: "Yes, I can just take photocopies of the relevant documents, is that okay?"

* Organiser: "Yes, that's fine, thanks."

In this case you are basically okay: You need to carefully check that the lecturer can indeed
give you the relevant permissions, and that you get the right forms signed and copies for
permissions from the lecturer as appropriate. Get some advice from somebody (such as
your institution's legal services) if necessary, but it is most likely fine.

Getting permission with commercial third party rights

* Organiser: "When we do the recording, we have to make sure that we comply with
copyright legislation. Could I double check whether you are planning to play any music,
DVDs, or film during the talk, or whether you are planning to recite some poetry?"

* Lecturer: "Ah, actually,I have rather a lot of music and film."

* Organiser: "What sort of film and music do you have? Is it commercial, or your own?"

e Lecturer: "No, it's all bought, some CDs, and some extracts from commercial DVDs. But I
always show these, and I have heard that in an educational context this is all fine."

¢ Organiser: "Unfortunately that isn't the case. There are very special conditions under
which materials can be use in educational contexts, but our public talks don't fall under
this, and recording the material certainly won't be possible."

What are your options? You obviously cannot go ahead and publish the talk regardless.
Also, it will be expensive and possibly long-winded to clear the materials, so that is rarely
an option (unless you have the budget, in which case at least music can be cleared
relatively easily).

On a low budget, and if you want as much of the talk as possible, you essentially have three

options:

¢ You ask the speaker not to use any third party materials. (You may be able to convince
the speaker that recording the talk would be great, and really help to promote your
cause, and so they may be happy.)

* You do not record the talk, and spend your effort on recording another talk instead.

* You record the talk, but edit out all third party copyright materials.

The latter option is really only recommended if there are not many third party materials
and if they can be removed easily. Therefore you need to talk more to the lecturer and see
what can be done. However, complications are common: Usually, if the editing is done by
volunteers, removing materials causes such long delays that the talk stops being topical
and may not be worth publishing anymore.
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A better cause of action would be to not use the entire talk but just publish some excerpts.
Alternatively, record a separate interview with the speaker or even record the speaker
giving a separate 5 minute summary of the talk. This would be much more efficient in term
of effort and look much better than a heavily excised lecture.

Getting permissions for presentation slides

The above focuses on audio recording because it is the simplest thing to do and avoids
problems with third party images in slides. Presentation slides can be hard to clear mostly
because they usually contain images. Images are more complicated for two reasons: The
speaker is much more likely to use images and tracking the rights is usually harder.

However, if the slides are entirely the lecturer's own work, i.e. if there are no images in the
slides (and no other graphics that may belong to a third party) then it is fine to use the
slides. You simply get the speaker to sign over the relevant rights.

If the slides have images/graphics you can of course use them if they are in the public
domain, e.g. if copyright has expired, or the owner has released them (say under Creative
Commons), or gives you adequate permission. Images from some organisation (e.g. NASA)
are also acceptable provided you follow the terms and conditions on their website. Note
that it is not neccessarily true that a person from an organisation can authorise the use of
photos owned by that organisation.

Release forms, legal forms, complicated forms

Once the speaker has agreed to sign a release form you must know what form to use. The
legal services of your institution will be able to advise you but such an approach can create
complications. Typically, if faced with a lengthy and overly legalistic form a lecturer may
simply decline to give permission whereas agreement may be secured if the lecturer had
been presented with a shorter form that uses clear, concise statements. Similarly, phrasing
the forms in terms of reciprocity can help; for instance, noting that you will provide the
lecturer with free copies of the edited recording.

With forms the first option is to use a copyright-assignment. This gives you the greatest
freedom, and could be recommended for situations where a performer is paid for their
performance or where the performance constitutes only a small part in the whole work (e.g.
a few sentences in a longer documentary). This is thus quite common for commercial film
work.

However, the lecture recording situation is quite different. The performance (i.e. the
lecture) is the main part, and it is also fully conceived of by the lecturer. Also, they are
probably giving the lecture (at least partially) as a gesture of good will, possibly without
payment. It would be quite unreasonable to expect the lecturer to sign away all rights in
that performance. You can follow two strategies:

¢ The University of Cambridge and the University of Oxford each have a 'license form'
through which the speaker gives the University a license. It means the speaker retains
copyright, and can do what he or she likes with it while giving the university a license to
use the recording. This is a good approach, but rests on form drafted by the institution's
legal services. Before any podcasts are published at Oxford they need to have two
signatures, a conventional speaker release form with a departmental signature.
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* An additional approach is to make the material available as open content using the
Creative Commons (http://wwwcreativecommons.org/) licensing scheme. In this
approach you would ask the speaker to license their work (their performance on the day,
and their slides etc) to your society (or to the world), e.g. under a 'CC-By' license (http://
creativecommons.org/licenses/by/2.0/uk/). The "You" in this case would be your
society/the world, and the "original author" would be you. As the license states, your fair
dealing and other rights are in no way affected by the above.

Creative Commons

We briefly offer a few more thoughts on Creative Commons licensing. Firstly, the Creative
Commons license is a license in perpetuity: That is to say, the lecturer gives you a license in
perpetuity, but if you give a CC license to the world, this is also in perpetuity: You are
unable to withdraw the material at a later stage. From an institutional perspective, this may
be a disadvantage, but from the users perspective, this is absolutely essential. The point of
CC is that others can build on your works, and so that you can build on works of others: For
this the licenses need to be perpetual.

The lecturer may not have licensed their talk as CC yet, so you might need to get something
from the lecturer that states their intention. It is not clear what the right approach would
be, but a common sense approach would be to get the lecturer to sign a simple letter, to the
effect that she or he wishes to license their lecture/slides under a CC license. For instance:

To whom it may concern.
I hereby license the performance of my lecture ..... [name of lecture/date] ..... and
associates materials (my slides, my photographs, ....) for which I hold copyright under

a CC-By (http://creativecommons.org/licenses/by/2.0/uk/) license. This applies to
all materials used in the lecture are my own.

3rd party materials: The following materials are not owned by myself ....... and I attach
permissions from the third parties concerned. These are licensed as state in those
permissions.

Signed ..... [lecturer] ......

Another consideration is that the CC licenses are usually one-to-many, so the license letter
may not need to mention you.

However, there needs to be much more discussion in the UK higher education sector over
the use of release forms and Creative Commons licenses.

Release forms
Release forms:

* University of Cambridge, http://www.admin.cam.ac.uk/cam-only/offices/
communications/services/photoconsent/ (Cambridge only)

* Univesity of Oxford, http://www.ox.ac.uk/itunes_u/contribute.html

Web 2.0 Rights:

¢ JISC-funded Web2.0 Rights project, http://www.web2rights.org.uk/
¢ Flowchart for considerations surrounding the release of content, http://www.
web2rights.org.uk/charts.html



http://www.web2rights.org.uk/charts.html
http://wwwcreativecommons.org/
http://creativecommons.org/licenses/by/2.0/uk/
http://creativecommons.org/licenses/by/2.0/uk/
http://creativecommons.org/licenses/by/2.0/uk/)
http://www.admin.cam.ac.uk/cam-only/offices/communications/services/photoconsent/
http://www.admin.cam.ac.uk/cam-only/offices/communications/services/photoconsent/
http://www.ox.ac.uk/itunes_u/contribute.html
http://www.web2rights.org.uk/
http://www.web2rights.org.uk/charts.html
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Disclaimer Statement: Whilst we hope you find the contents of this booklet useful and
informative, the contents are for general advice and best practice purposes only and do not
constitute legal advice. We can give no assurances or warranty regarding the accuracy,
currency or applicability of any of the contents in relation to specific situations and
particular circumstances, appropriate professional legal advice should always be sought.
The rest of this page is intentionally left blank for your own contributions! Please

contribute to these tutorials by visiting Steeple at http:// www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=8048

Contributors: Bjoern, Karl, OLewis, PeterRobinson
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Recording

Tutorials/SteepleBooklet/Recording
a podcast

In creating a podcast first of all you will need a headset with microphone to make and
check the quality of recordings. Alternatively use a dedicated portable recording device
such as a digital dictaphone, recordable MP3 player, or PDA. You may already have some of
this equipment but if not your institution's computing services or learning technology unit
probably has equipment they can loan. If not write a short teaching and learning proposal
to cover set up costs and submit this to your head of department without delay. NB: You
may need to get permission to make recordings of teaching sessions and students.

There are many means of recording audio and video for podcasts, with varying levels of
expensive and complexity. At the basic level, to create a podcast you would need:

* A relatively modern computer with speakers and internet connection.

* A microphone. Some computers have an in-built mic, but a more expensive external mic
will create better quality audio recordings.

» Digital recording software (such as Audacity) to create the audio files. However, there
are software packages (such as ProfCast on the Apple Mac) designed specifically for
audio and video podcasting that may now be more suitable.

Audio podcasts (usually MP3s) are easier to create and the filesize is more manageable for
upload and download but nevertheless it is now simple to create video podcasts using
podcasting software. In addition to the requirements above video requires a video camera.
This can be a simple USB webcam or a more expensive digital video camera connected to
the computer.

It is possible to record audio podcasts into portable media players (such as an iPod with a
mic attachment) but the quality is not necessarily high. By far the simplest method is to
record directly into a computer using its own internal mic, but the audio quality will not be
exceptional and the mic is likely to pick up background noise (from the computer's fan, for
example).

Regardless of the means by which podcasts are recorded, to publish them it is usually
required to transfer the recording from the recording device to a computer with access to
the internet. In general, the fewer steps required to generate the final podcast file on a
computer, the better.
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Other options for recording
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e A portable recorder, such as a Fostex FR-2LE or a Marantz PMDG660 Solid State
Recorder can be a relatively inexpensive and yet high quality option for audio recording.
Many of these portable recorders make use of CompactFlash cards and other modern
storage cards.

* Expensive external USB (not analogue) microphones (such as a Samson CO1U USB mic)
can be plugged directly into a computer and provide very high quality audio recordings.
Additional attachments to isolate background noise can increase the quality.

¢ Digital video cameras can be used for audio and video input for use in podcasts, and
these can record onto DV tape (which would then have to be transferred to the computer
using a separate piece of hardware) or can be plugged directly into a computer
(commonly via FireWire). These usually provide high-quality audio and video recordings.

* High-end audio mixing equipment (such as M-Audio’s NRV 10 FireWire Mixer) is
expensive but can be plugged directly into a computer and handle high-quality audio
input from multiple wire or wireless transmission microphones. Such mixers provide the
expert with a greater degree of configuration for eliminating unwanted sound and more.

¢ Tape recorders of various levels of expense can provide a safe means of long-term
storage of audio and video files, but the added steps required to transfer them to a
computer and the more modern means of recording call into question their immediate
value.

Preparation

Prior to recording a podcast, like any lecture or public-speaking, preparation of the content
is necessary. It is also vital to test the recording equipment prior to recoding the final
podcast; a few trial runs of recording the audio and video through the mic or the mic and
camera setup. These trials will give an indication of the level of quality of the final podcast
and allow these settings to be adjusted accordingly.

During the trial stage it is wise to check the system volume of the computer to ensure the
microphone is the selected audio input device, and that its input level is set appropriately.

e For audio voice recording the suggested quality is 44.1KHz and 16-bit sampling which
should produce a clear, crisp sound. Higher quality settings may be required if the
podcast contains music, or for more professional / commercial requirements, such as an
important public lecture.

Always ensure that the audio is set to capture at sufficiently high quality and that you have
enough file storage space on the device when you start. Audio quality can always be
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reduced later to make the podcast file size smaller but it is much harder to improve the
quality of recordings at a later date.

Some important considerations when recording audio:
* Ensure there is limited background noise because many mics will pick these up. It is
worth considering a noise-reduction attachment for more expensive microphones.

* Position the mic accordingly, so that the voice is clear but unwanted sound (computer
fans, a person breathing) is minimal.

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http:// www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=7978

Contributors: OLewis, PeterRobinson

Tutorials/Baseline audio kit

Below is a sample collection of a good range of audio equipment to cover three basic
applications:

1. High quality lecture recording using a high quality recorder and a high quality radio
mic.

2. Round-table discussion recording, using a high quality recorder and good quality
omni-directional microphones.

3. Quick audio gathering that provides a way in for less experienced individuals and also
facilitates quick recording of discussions and talks, albeit at a lower quality.

The proposed equipment is:

* High quality kit

* Fostex FR-2LE for high quality recording (about GBP £350 for the recorder plus
accessories).

* High capacity rechargeable batteries (four for the recorder and a fast charger, around
GBP £30).

* A set of headphones. These should be proper headphones that go around your ears,
rather than in-ear. For speech work almost anything will do. You could get a cheap
AKG K512 from Richer Sounds for GBP £20.

* Spare memory cards (it is worth getting 4GB cards), GBP £20.

* A soft, ideally padded, shoulder-bag to hold the Fostex, the XLR cables, headphones,

and other accessories. Approximately GBP £30.

A reasonably sized plastic crate (with lid) that can hold all the equipment: The case
stays in the office and holds everything that is not signed out when the bag goes out
(GBP £10)

¢ Radio mic (Sennheiser EW112P), GBP £350.

* High capacity rechargeable batteries (you need four for the mic kit, so get eight to
have spares)
* A pouch that just holds the radio mic, GBP £20.
* Several mics for table top discussion recording, e.g. get two Audio-Technica AT8010
(Omnidirectional Condenser, GBP £100 each), or Audio-Technica AT8004
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(Omnidirectional Dynamic, about GBP £100 each). The AT8004 is more rugged, and
probably better for for novice use (including outdoors). The condenser is more sensitive
but does not handle drops well and might need a proper wind-shield outdoors.

* Table-top mic stands (GBP £10 each)
* Some XLR leads (you need at least two times 10m, better four times 10m, at GBP £10
each)
* Standard quality recorder (for quick recordings)

* H2 recorder for simpler recording (GBP £150)

* A spare memory card (GBP £10)

* A pouch for it that holds the recorder, cabling, and memory cards (GBP £20)
* You need two rechargeables, so get four (GBP £10)

Other thoughts

* If you were going to do handheld interviews (rather than discussion recording) you could
use the Behringer M58 or the Audio-Technical AT804 mic. The Behringer is a nice mic: It
has a long grip, and is not sensitive to handling noise. However, the low sensitivity
requires you to be quite close to the subject and so the mic is not so good for ambient
table-top recording.

e If you have the budget buy a second sennheiser radio mic.

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http:// www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=7894

Contributors: Bjoern, OLewis
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Audio recording using a digital
recorder and wireless mics

This tutorial will show you how to make a high quality audio recording with the Fostex FR -
2LE (Field Memory recorder) and a Sennheiser EW112P G2 series radio mic. Most
comparable audio recording devices have a very similar layout and operate along the same
principles as the Fostex used in this tutorial.

L

There are a few solid state recorders that have similar functionality to the Fostex FR2-LE
(basically a CompactFlash based recorder with XLR mic sockets), as well as many solid
state recorders that do not have XLR inputs). You should compare usability and sound
quality carefully, ideally before committing to a purchase . For a number of recorders,
including the Marantz PMD660 , the Zoom H2 and the Edirol R09, customised versions of
this tutorial are available here http://en.wikipedia.org/wiki/Tutorials%2Faudio_recording.

Your equipment: The Fostex FR-2LE and
Sennheiser EW112P

Before You Start: Make sure you have all the correct equipment and that it is all in working
order. Typically, an audio recording kit around the Fostex FR2LE might include:

* Fostex FR - 2LE (Field Memory recorder), including CF memory card (already
inserted), along with AC adaptor. (There is also a battery compartment, and you can run
the recorder off batteries.)

¢ One set of radio mics (Sennheiser EW100 G2 series). You need to have:

e 1 transmitter with lapel mic attached (check the wind shield is on the mic and
securely attached)
¢ 1 receiver with two cables: one minijack to XLR, one minijack to minijack
e This image Image:FR2LE-A-7.jpeg shows the mic Kkit.
¢ The recorder comes with a remote control for use with a boom as well as carrying bag
and shoulder strap. (You will not need the remote control or boom for this tutorial but
you should use the case to transport the recorder safely.)

To power the equipment you can either use the AC adaptor (mains power) for the Fostex
FR-2LE or 4 x AA batteries for the battery pack. The radio mics need 2 x AA batteries in the
transmitter and 2 x AA in the receiver, i.e. you need 8 AA batteries for a full charge. Ideally
you would use rechargables - the EW100 G2 series runs very well off rechargeables. If you
are recording away from mains be sure to take spares in case the battery life runs out. All
equipment has a battery life gauge to show remaining battery life.

You may want to have the manual to hand: http://www. fostexinternational. com/ docs/
pro_support/ FR2LE_OM _E. pdf (from http:/ / www. fostexinternational. com/ docs/
pro_support/ pro_pdf _manual. shtml). Note that the V1.10 and V1.20 firmware upgrades
enable mono recording, see (http:// www. fostexinternational. com/ docs/ pro_support/
FR2LE V110 supplement. pdf) and (http:/ / www. fostexinternational. com/ docs/
pro_support/FR2LE V120 OM_ supplement.pdf) respectively.
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Names and Functions:

Front of the recorder (important)

Here is a quick run through of the
FR2-LE - make sure that you can 1 ' 2 3 4
identify the relevant parts of the
equipment. All important controls
for recording are situated on the
front of the recorder.

* 1) Memory card slot protection
cover

e 2) The memory card slot itself,
with card eject button.

¢ 3) Mic peak indicators -
indicators will light up when the
input is 'overloading' ( (=1

* 4) Level Meters - shows the @’ @’ ﬂ Lg’
recording or playback levels.

¢ 5) Recording level control - adjusts the input level for recording but does not influence
the internal microphones. (These are linked to the level meters (4). If the level shown on
the level meters is too low or too high, use the recording level control to adjust this.)

* 6) Record (REC) button - slide the button across to begin recording.

* 7) Record Standby (REC STBY) button - press this button when ready to record. It allows
you to check the input levels and can be used to stop recording.

* 8) Monitor control - adjusts the output levels of either headphones or a monitor. It can
also adjust the output levels of the internal speakers.

* 9) Mic Trim controls - adjusts the input level of external microphones from Analog in
connectors L and R. (They are linked to the mic peak indicators (3) - If the mic peak
indicators light up, you need to reduce the mic trim.)
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Top of the recorder

On the top of the device you only

need the LCD display; the other J1 ‘ |3 w :5

controls you can look at later when E L{ L\A —
you are copying materials off the o \ 8
recorder or when you are playing

back some audio.

1) LCD Display Screen | = -

. _ “; E . - N
2.) Internal M1(.:rophones y i = - =B 17
situated both sides of the panel '
as Internal L and R inputs.

|
B

3) Light / Contrast - allows you E»‘“
to light the screen. Hold the [~ ] (n} 8@

6 9] [12] [10] (13

button down for a few seconds
for the light to stay on, press
again to turn off. This allows you to adjust the screen contrast.

4) Shift - press and hold this button whilst using other buttons to enable the secondary
operation.

5) Menu / Enter - pressing this allows you to enter the menu option and is used to select
each setting. Using shift with the menu button enters you into a quick setup mode.

6) Prev File - when more than one file is stored using this button will skip to the previous
file. Pressing this button with shift allows you to go to the previous cue point if any are
set.

7) Next File - when more than one file is stored using this button will skip to the next
file. Pressing this button with shift allows you to go to the next cue point if any are set.

8) + / Up key - while in menu mode this button allows you to scroll up. Used with shift it
will lock the panel.

9) Rewind - allows you to rewind through files.

10) Fast Forward - allows you to fast forward through files.

11) - / Mark key - by pressing this key whilst recording or playback marks a cue point, in
the menu setup it scrolls down and with shift will delete the previous cue point.

12) Stop key - stops the files and exits the menu screen from any mode.

13) Play key - starts playback of files.

Left side: Audio inputs (important)

b 2 3
1) DC in Jack - used to connect the AC Adaptor.
2) Remote Input - used to connect the remote control.
3) ANALOG IN - used to connect an external microphone.
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Right side: Power and headphones (important)

14 3]
¢ 1) Power Switch - turns recorder on and off. To turn off hold the power switch up for
two seconds.
2) USB Port - used to transfer audio files to and from a computer.
3) Monitor Output - these connectors output -10dBV analog audio signals.
* 4) Headphones Jack - allows you to connect headphones to the recorder to monitor
audio.

L]

Back: battery compartments

* 1) Battery Compartment - This compartment houses 4x AA batteries.

Setting Up:

Setting up the memory card

We have had a problem where even though you have manually deleted all files from the
Fostex so that the memory card is empty, the recordings are not actually deleted from the
memory card and the card may unexpectedly run out of space. For example, the recording
stops half-way through the talk displaying a screen which reads 'Disk Full. Press enter to

return to the main menu'.

To ensure this does not happen, when you turn on the Fostex for a new recording, reformat
the memory card. You can do this by pressing 'Menu', then selecting 'Disk', and then
'Reformat'. This will clear all files from the memory card. It will also, however, reset the
Fostex settings so you will have to enter them again. (You want the settings to be

BFW44-16.)

If for some reason the card has not been cleared and you suddenly get the "disk full"
warning in the middle of a talk just exchange the memory card and keep recording. It does
not matter too much if there is a small break in the talk. This is why it is important to

LISTEN TO THE RECORDING AS IT IS HAPPENING wherever possible.
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Setting up the digital recorder with the wireless mics

Have the recorder on a flat surface in front of you and either connect the AC adaptor into
the power input and a nearby power socket. If you use a power socket, make sure that
nobdoy will trip over the cable - use gaffer tape to tape down the cable if necessary. The
power input for the recorder displays a "-" and "+" symbol and is located next to the
remote socket.

Using the radio mics, the recorder does not have to be close to the transmitter - it will pick
up from a distance as long as there is nothing substantial between them such as a solid
wall. To connect the radio mics to the recorder insert the large silver plug (XLR cable) into
the ANALOG IN connectors and the smaller end connects to the reciever. Use just the L
input for one mic; use and L and R if you have two mics.

The picture shows (left to right): power connection, the remote control plugged in (not
needed), and a single mic connected to the left input of the recorder:

Also connect your headphones to the "phones" connection on the right hand side of the
recorder.

Radio Mic transmitter

If the mic is not already attached, attach the clip microphone to the transmitter: The mic
plugs in at the top, and there is a screw to secure it.

~ Clip Mic Input

=

Turn both the transmitter and receiver on by pressing the on/off button, which is situated
underneath the flap for the battery compartment. The flap lifts by squeezing either side to
release it.

Have a look at the picture above, and do this check:
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* On both transmitter and receiver: Has the display lit up, and are both powerlights
showing?

* On the receiver the RF light (green) should be on and and the upper black bar on the
screen should be on full (indicating full radio reception).

* When you talk into the mic do the level indicators (on both the transmitter and receiver)
flicker?

* Now mute the transmitter and look at the receiver: Has the "radio reception bar" fallen
to zero? If not, change frequency (see the trouble shooting below).

There are usually several stages that control audio levels and two of those stages are on the
radio mic set.

* The mic/transmitter has a sensitivity setting. Locate the sensitiy setting in the menu, and
explore different settings. With the sensitivity set to say -6dB, you will find it quite easy
to distort mic signal (the yellow led on the front will flash). A good, conservative setting is
-20dB.

* The receiver has the 'AF out' setting, which determines the power delivered to the
recorder. This can range from -12dB (mic level) to +12dB (line level). Again you should
explore this and see how it affects the input stage of the recorder (see below). Many
recording devices expect a mic level, so it is safer to set the 'AF out' level to -12dB (mic
level).

Switching on and testing sound quality

Switch on the power switch on the right hand side of
the recorder. The screen will turn on and make sure
that in the bottom right of the screen it says BWF
44-16. This is the correct format for recording.

Make sure the bottom option on the right of the screen
that says "SRC" (which means source) is set to INPUT
according to the ANALOG IN position you have
plugged the mics into. Otherwise it could be set to
record from the internal microphones.

Testing soudn quality

You must do this test: Switch off or unplug the external microphones. Does the sound in
the headphones disappear? If not, you are recording from the internal mics. Also, you can
gently scratch the external mics, e.g. on the handle, or gently tap the mic itself: Do you
hear this in the headphones? If yes, then you are recording from the external mics as you
should be.

To test whether there is sound being picked up look at both the transmitter and receiver. If
they are on the same wave length both screens should be showing the activity coming
through the clip mic. Now turn on the REC STBY switch on the front of the field audio
recorder and the same activity should be shown on the recorder screen.

Try tapping, scratching or speaking into the microphone while watching the levels. They
should coincide with the activity coming through the microphone. You should also hear the
activity coming through the headphones. Try testing that the internal microphone is not
picking up any sound by tapping on those. They should not register anything.
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Trouble shooting

¢ No sound. Make sure both the transmitter and the receiver are on the same wave
length in order for them to be able to pick each other up. Check the 'sound chain':

¢ Is the level meter on the transmitter flickering when you speak into the mic? If not,
check that it is turned on and not on mute and that the mic is properly connected.

¢ Is the level meter on the receiver flickering? If not, check radio reception.

* Is the level meter on the recorder flickering? If not, check the cables are connected
properly.

* All of these are working, but you do not hear anything? Check the volume control for
the headphones.

* Strange sounds / other people speaking.

* Do this test: try turning the transmitter off, if the green light on the receiver stays on
and the black bar showing the radio reception is still full, someone nearby may be
using the same frequency.

e If the wave length is already used (e.g. if you can hear other sounds, or the "radio
reception bar" does not fall to zero when you turn of the transmitter), you need to
change the frequency (on both transmitter and receiver). You must never have two
microphones transmitting on the same frequency. (Two receivers receiving
signals from the same microphone is, however, fine.)

Mobile phones on the person connected to the mic must be turned off otherwise
they will interfere.

Attaching microphone to the speaker

Ideally you want to do this at least 15 minutes before
the lecture starts. Connect the clip microphone to the
speaker in a way so that the mic "comes cleanly off the
clothes", i.e. such that the mic does not rub against the
clothing. Make sure that there is not a name tag, long
hair, or jewelry that "clunks" against the mic.

When putting the mic on the speaker the best place is
on the tie. Otherwise on the lapel of a jacket, or onto
the shirt. A third of the way down the shirt is a good Attaching the mic

position. Make sure that the mic clip is firmly attached

but that the mic itself comes away from the clothing: sometimes (with movement) it can fall
back against the clothing.

The transmitter that should be placed safely out of the way. Either the trouser pocket or
belt are both good positions. If your speaker is well animated make sure the transmitter will
not come loose. Make sure the antenna can hang freely, and is not about to be snapped off.

Ask your speaker to carry on talking, bearing in mind that they may speak more loudly
during the talk. This allows you to listen through the headphones and watch the levels on
both the receiver and recorder. Monitor the audio carefully and pay attention to any peaks
in the sound. Be aware that if the speaker is going to be giving a lecture but they are
speaking at a normal level before, they will adjust their own personal voice levels when it
comes to the lecture.
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Checking Quality and adjusting audio levels

Before the lecture is under way

you have a good opportunity to Mic Peak
Indicators Level Meters

check quality. If anything is wrong
you can still go back to the
speaker and adjust things.

Make sure the REC STBY switch
is on: you can tell as a green light
should be on above the switch. You
will not be able to see levels of
audio on the recorder as well if the
switch is not on.

You need to set up the levels using
a two pairs of indicators and
controls:

e Pair 1: Input level controls (Mic I' el Lol

Control
trim, 9) and Mic peak indicators Input level
Controls
(3).
* Pair 2: Recording level controls Quality and adjusting audio levels

(5) and recording level display
4).

Note that pair 1 (mic trim) affects the level recorded with pair 2 but the reverse is not true:
the recording level control has no affect on the mic peak indicators.

1. Step 1. You should start with the mic trim buttons pointing straight up. Talk loudly into
the microphone. Do the mic peak indicators light up (for the relevant channel)? If so,
reduce the mic trim (turn counter-clockwise). If not, you are fine.

2. Step 2. Move on to pair 2 (recording level controls). Talk into the microphone as if you
were giving a lecture and turn up the recording level control until the recording level
display shows goods activity, with green leds lighting up reasonably often at -12dB, very
occasionally at -6dB, but never higher.

3. Step 3. If you have turned the recording level controls (5) all the way clockwise and you
are still not getting good sound levels go back to the mic trim (9) and turn the mic trim
clockwise to increase the input level, and then go back to step 1, checking that the mic
trim has not been increased too much.

Note that with some mics (e.g. the Behringer M58) it is not possible to overload the inputs
and you might have to have the mic trims up fairly high. This is not a problem as long as the
mic peak indicators (9) do not light up when you speak into the mic loudly!

Finally, listen to the speakers voice and check the quality of the sound. Does it come
through the headphones clearly? Or is it muffled or can you hear extraneous sounds? If so,
see the trouble shooting section.

If the levels on the recorder LCD and microphone LCDs seem good but still you are not
hearing the sound either at all or not clearly then either the headphones are turned down
or the headphones are faulty. You can adjust the volume by altering the monitor control
next to the input controls on the front of the recorder (button 8).
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Recording the lecture

You should now be ready to record the event. You have plenty of space on the memory card,
so there is no harm in starting the recording 10 minutes early. From experience: It is a
common problem to miss the start of the event and people may suddenly start to talk while
you were not watching. So just start recording in good time.

If there is somebody introducing the speaker, record this as well (even if you you do not
have a mic on them). You can always cut it later. (Imagine the disappointment: Did you
catch the introduction by [famous person]? - Ah sorry, the recorder was not running.) Of
course without a second mic the sound may not be usable but at least you have it.

As mentioned above: Give enough pre-record time before the activity happens as you want
enough pre-roll for the edit and if you do a test recording previously you will also be
confident that either the recorder is working fine or you have enough time to sort the
problem out!

Remember: What you hear in the headphones is what you hear on the recording so
continously check the audio for any outside sound, buzzing or feedback. If you are
recording on location and have the ability to start recording again listen out for unwanted
sounds that are out of your control, such as trains going past, dogs barking etc.

During the Recording: Whilst recording it is advisable to do some checks to make sure the
recording is working properly:

* Is the record light on display of the recorder solid?

¢ Is the time display ticking forward?

* Are the level meters still running and showing activity?
¢ Does it sound good? Is it clean sound?

* Is there enough space on the memory card?

When you are ready to record press the "record" button on the front of the recorder. You
should see the light come on within the button and the time on the screen should start
running. You will also notice a record symbol in the top right of the screen.

Stopping Recording

Press "Stop" when you have finished recording. The REC STBY switch will also stop
recording. Do not press stop right at the end of the lecture but rather leave the recording
running through the Q&A session. The speaker might say a nice short clip that you can use
as a sound bite.

Make sure you get the radio mic transmitter back from the speaker! Speakers can easily
wonder off with your mic. Also make sure that you have got an appropriate release form
signed by the speaker. Just after the talk may be a good occasion to get this done.

Once you have finished recording make sure everything is turned off and packed away
safely, making sure you have the whole kit - check against the kit list if necessary.
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Transferring your recording to a computer

When you are ready to import your recording connect the USB cable to both your computer
and the recorder. Once they are connected and your computer is on press the "menu"
button. Scroll down using the "-" button until you get to USB Mode. Press "enter" then
scroll down to USB DEVICE MODE. Press "enter" again and this will start importing. You
will see the new USB connection on your computer either in the "finder" or for a PC in
"My Computer”. You can then drag your recordings into a suitable file or your desktop
from there.

It is best to copy the recording from the memory card to the computer rather than moving
it. Computers can crash, and you do not want to loose your recording. Generally speaking,
you would only delete the raw recording from the memory card when you have got a
backup on CD or DVD.

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http:// www. steeple. org. uk/
contribute"
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Introduction to editing

Editing is a relatively laborious process. You will have to go through your audio, bit by bit,
and remove each section of audio that is irrelevant or unnecessary. It is slow, but worth it.
In conversation, even lectures, we often jump off topic or simply pause while we speak.
While fine in conversational speech, podcasts are different because we want them to be
relatively fast-paced and easy to follow. As such, we edit this audio out.

You might also wish to record an introduction or closing remarks for the podcast. Many
sound editing software programs have features that allow you to record additional material
directly into the computer and then attach this to the beginning or end of the larger
recording. Some of the most successful podcasts have a standard introduction to an entire
series, or will outline the contents of the podcast ("In today's podcast...").

Software for editing
Simple:
¢ Audacity, for recording or editing sound (PC/Mac), http://audacity.sourceforge.net/

¢ Audacity requires the LAME MP3 Encoder to save the audio files as MP3: http://
lame.sourceforge.net/
¢ iTunes, for converting audio files to MP3, http://www.apple.com/itunes/
* Windows Sound Recorder, but the quality will not be exceptional.
¢ Podium is a complete commercial podcasting solution for Windows with a robust audio
editing toolset, http://www.podiumpodcasting.com/
* GarageBand is a multi-track recorder with podcasting tools - Mac, http://www.apple.
com/ilife/garageband/
ProfCast is professional podcasting software tailored specifically for educational needs -
Mac (PC version in development), http://www.profcast.com/

Advanced:

* Cakewalk, http://www.cakewalk.com/

* Steinberg CuBase, http://www.steinberg.net/

¢ ProTools, a widely-used professional suite, http://www.digidesign.com/

¢ ePodcast Producer is expensive professional podcasting software for the PC, http://
www.industrialaudiosoftware.com/products/epodcastproducer.html

¢ Sony Vegas series suite is a high-end commercial audio and video editing software
package, http://www.sonycreativesoftware.com/products/vegasfamily.asp

e Apple's Logic Studio is a professional audio suite for Apple computers, http://www.
apple.com/logicstudio/

¢ Rosegarden, open source editing software for Linux, http://www.rosegardenmusic.
com/
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A quick note about Dynamic range compression

Ever wondered why the recording sounds so quiet? Speech recordings naturally have a
large dynamic range and you will have left enough head room to make sure you get a good
recording. In the edit you need to remove the headroom (normalisation) and reduce the
dynamic range to make the recording suitable for playback via laptop, radio, personal MP3
player. Unless you are planning to produce theatrical sound for cinema performances you
need to apply dynamic range compression!

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http://www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=8120

Contributors: Bjoern, OLewis, PeterRobinson
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Three important notes for not losing work

1. When starting a new project always save your blank project first, before you start
working. (Otherwise the auto-recovery fails.)

2. Always make a 'surrounding folder' in which you save a particular project. Then when
moving your project move the 'surrounding folder'. Never just move the '.aup' file.

3. If Audacity crashes unexpectedly, read the 'auto recovery' section below. You may be
able to recover your work.

Crash Recovery

Like with many other software Audacity can occassionally crash. Fortunately there is a
recovery option that allows you to recover unsaved work after crashes. When Audacity
crashes first make sure that Audacity really has crashed and you cannot see any open
Audacity windows. Then re-open audacity. You may see the following error message (we
will show you later how to remove this message). Make sure Audacity is not running then
select 'Yes'.

Error locking temporary folder

Asdacity was not able to lock the temporany files directory

P This folder may be in uie by another copy of Audadity
Running two copies of Audacity simultaneouwsly may cause
data loss OF CAUSE YOUF FyStem 1o orash

Do you still want to start Audacity?
Mo Yes

A crash recovery screen will now appear with Audacity giving you the option to recover you
project. Select recover projects and this will load the projects you were using before the
crash.
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Automatic Crash Recowvery

Some projects were not saved propercky the last time Audacity was run,
Fortunately, the following projects can automatically be recovered

Recowerable projects

Name i
test - 2007-10-10 11

Recovering a project will not change any files on disk before you save it.
Quit Avdacity Dan't recover Recover projects

Once the project is back running to save your work.

Crash recovery: Removing the "lock file"

If Audacity crashed you might keep seeing the message below every time Audacity starts.
Here is how to fix this.

Error locking temporary folder
Audacity was not able to hock the temporarny files dinectory
This folder may beé in use by another copy of Audadity.

Running two copies of Audacity simultaneously may cause
data loks OF CAUSE yOur system o crash

Do you still want to start Audacity?
Mo b Yes

If the "error locking temporary folder" keeps re-appearing you need to remove a particular
file called a "lock file". To do this enter "Podcast course" > "Audacity Applications", and
then the "Temporary" folder. Go to "Audacity temp". You should see a file called
"audacity-lock-username". Delete this file, either using "Backspace/Delete" or dragging the
file into the "Trash".

& Audacity-Macintel) LTI T ™ audacity-lock-andrewtaylor
M Audacity-Win0.exe

Languages

LICENSE. It

Nygquist

Plug-ins

Portabie Settings
| README.txt

Temporary

4= Audacity-Macinzedd audacity_temp
W Audacity-Win0.exe

Languages
1 LICENSE txt
Nyquist
Plug-Ins

The "Audacity temp" folder should now be empty and next time you start audacity the error
message will not appear.

Source: http://www.ict4e.net/wiki source/index.php?oldid=8121
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Contributors: Bjoern, OLewis, PeterRobinson
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Outline

This session will introduce you to Audacity (a free cross-platform audio-editing
application).You will learn how to set up Audacity and how to record, manipulate and save a

sound file suitable for use in a course, project, podcast or on a website.

The Audacity website is http://audacity. sourceforge. net/ (http://audacity. sourceforge.
net/). The software is Open Source meaning that it is free and can be modified by anybody
with the appropriate skills; you can make a donation to the authors though - this will help
the project prosper!

Browse the Website, have a look at the tabs at the top - they include comprehensive help
and user guides. There are different downloads for different operating systems and
plug-ins, etc. There is also an Audacity wiki and user community area.

To install Audacity on your own machine you should download the latest ‘proper’ version
(ie, not a Beta version): the Windows version is downloadable from the front page of the
site; other versions are available via the ‘Download’ tab.

¥ Audacity: Download - Mozilla Firefox
Ele Edt View Hgtory Delckus Took Hep

ai- e

] Most visited () Google Calendar % Dashboard - OUCS JIRA | | StartPage - Webleam... W/ wikipedia [[C]-]king wi

=12l

o Bl @ W e sourcelorg oad/

g © - - [A] hwsrauday

1 pubs haikey ;

| Google Calendar WebLearn (bata).

m;ludacity

rome | [bout] [ oownioaa | [reip] [Contactus | [Getinvoived

% [#WL-375] add I X. Design Presentati ¥ [#S8K-10747] 51 5 Audacity: Dow... (3 | -

Google saal| ||

@ this ste © WikiForum/Team site © Web

[ AudacityStore.com J

Download Download

Stable: 1.2 Select your operating system to download the |atest version of the free Audaciy sound editor

Stable: 1.2 -for all users
Latest versions:

Beta: 1.3 - for advanced users
Latest versions:

&8 Windows 126

& Windows 135

Relessanges
New Featyres in 1

Windows

Mac OS X ‘:
1.2.5 (Intel) or 1.2.6 (PPC)

Mac OS X

3.5 (Universal Binary)

D Linuxiunix

1.2.6 (in source code)

A4 Linuxunix

3.5 (in source code)

Legacy Downloads

For users of Mac 0§ 9. a legacy 1.0.0 version of Audacity is also available on the Mac dovninads page.

Further i

* You can also obtain Audacity as a C0 image file or purchasable GO

o If you wish to complle Audacity yourselr, please downloan the source code

L®

It is also recommended that you download (or read) the Quick Reference Guides and / or
User Manual, these are available under the ‘Help’ tab.

oone FEEES

Note: Audacity is not necessarily the best choice for musicians and video post production.
There are other software packages listed which are more suitable. An example of one of the
drawbacks is that the ‘Effects’: Echo, Compression, etc are printed onto the source file; in
other words you change the source file rather than routing the source file through an
effects processor as happens with other systems. Another point to note is that Audacity
does not have a mixer meaning that it is not particularly good for playing two sources at
once. It also lacks a sequencer for syncing with MIDI instruments. What Audacity is good at
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is simple sound recording - there is probably no need to buy a package to do this as it runs
on Windows, Linux and MacOS.

You can use the project menu, import audio command to import MP3 files and WAV files
into Audacity.

If you are expecting to want to save sound files in MP3 format then you also need to
download and save the ‘LAME’ MP3 encoder. This library is also free but must be
downloaded separately from the main software (probably) due to licensing restrictions.
Type ‘LAME MP3 encoder’ into the Google search box at the top of the page, this will give
you a page of explanation.

Read the instructions and then visit the LAME website: http://lame. buanzo. com. ar/
(http://lame.buanzo.com.ar/) - versions exist for Windows, MacOS and Linux. Download
the appropriate ZIP file and expand and save ‘somewhere sensible’. (This may mean ‘My
Documents’ or possibly ‘Program Files’ or equivalent.)

Once you have saved the LAME encoder, you need to tell Audacity where the library can be
found. To do this use ‘Edit’ > ‘Preferences’ > ‘File Formats’. Then click on the ‘Find
Library’ button and navigate to the ‘sensible’ place where you saved LAME.

Audacity Preferences

Audiol.-"D] Quality  File Formats ]Spectrograms] Directories] Interface Keyboard] Mouse]

‘when importing uncompressed audio files into Audacity

" Make a copy of the file before editing [safer]
* Read directly from the original file [faster)

Uncompressed E xport Fomat

[wey Microsoft 16 bt PCM) |

ity [Microsoft), Signed 16 bit PCM

0GG Export Setup
0GG Qualy: | 5 0 )' 1o

tP3 Export Setup
MP3 Library Yersion:  LAME +3.97

Bit Rate: 128 =

Cancel | Ok |

Setting up and recording a sound file

Equipment

To make a spoken word recording, you need a decent microphone and decent set of
speakers. A poor microphone means that your original sound source will not be good and no
amount of editing and enhancement will make it sound professional. A good pair of
speakers with a flat response is also essential. If your speakers do not faithfully represent
the actual sound (for example, they do not play treble very well) then you may end up
boosting frequencies that are actually present but that you cannot hear through your
speakers.
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Configure Audacity

The first thing you (may) need to do is to set the audio input and output; this is done via
preferences. It is probably best to choose your soundcard for output.

Audacity Preferences

Audio /0 |Quality| File Formats | Spectrogiams | Directories | Interface | Keyboard | Mouse |

~ Playback
Device: IMicrosoft Sound Mapper - Output ;I
~Recording—
Device: IHD Audio front mic LI
Channels: |1 [Mona) ;I

™ Play other tracks while recording new one
I Software Plapthrough [Play new track while recording it)

Cancel | ()3 I

As you will be recording via a microphone, select that as the input source. A mono channel
should be OK.

Audacity Preferences

Audio 140 |Quality| File: Formatsl Spectrogramsl Directoriesl Interfacel Keyboardl Mousel

~ Playback
Device: IMicrUsUfl Sound Mapper - Output ;I
~ Recording
Device: |HD Audic front mic LI
Micrazoft Sound Mapper - Input
Logitech Mic [Communicate STx)
Channels: S aundhas HD Audia

I~ Play ather tracks while recording new one
[~ Software Playthrough [Play new track while recording it)

Cancel | Ok I

The signal level (volume) of low cost microphones with no pre-amp is an issue so make sure
the sound card is set correctly to maximum boost and the microphone is selected as input
source for recording. You should also check that you have not muted playback from your
PC. This is done via ‘Start’ > ‘All Programs’ > ‘Accessories’ > ‘Entertainment’ > ‘Volume
Control’.

Check ‘Master Volume’ is not muted or at zero; also check that ‘Wave’' playback is not
muted or at zero. The check the input source click on ‘Options’ > ‘Properties’; all PCs are
different but you need to check that microphone recording is enabled for the input socket
you are using. The following has enable input via the red ‘phono’ socket on the rear of the
PC.
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Mimer device:

—Adjust volurme far
" Playback

& Recording

£ ke I ;I

Show the following volume controls;

Rear Input
[ steren Mix

K 2
k. I Cancel |

Recording
Now it is time to record a track. Click the big red record button and speak into the
microphone. Adjust the input level so that the level indicator peaks at about -3dB.

= Audacity _|a| x|
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| Audio Track ¥ | 1.0
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3

|Record
Froject rate: 44100 | [Cursor: 0:00.000000 mincsec [Snap-To Off] p.
S

Select the track by clicking on it (it should change colour). Now make a copy, do this by
selecting ‘Edit’ > ‘Duplicate’. (You could also use ‘Cut’ and ‘Paste’.) You now have two

tracks of the same material.
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Name both tracks by using the drop down arrow in the track view. Call the first “original”
and the second, “edit track” (or something).
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Next select ‘View' > ‘Fit in window’' to see the whole audio track. You can change the
resolution of your view using the zoom tools or click and drag at the track edges.

Editing a sound file

Cueing Up

A good thing to do is to delete the silence at the beginning of the recording. To figure out
where the silence ends you should use both your ears and eyes! Select the silence and
delete using the delete button on your keyboard.

s Audacity i [=lk)
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Fade In

Next select a short segment of file from the beginning of the file and then choose 'Effects' >
'Fade In'. This is very useful to avoid a surprisingly loud signal from the start. It allows the
listener time to adjust to what they will be hearing.

ol x|
File Edt Visw FProject Generats | Effect énabzs Hsp
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ik 8pace remtins for ecording 154 pours s [1A5E e

et Repeat... —
Frojectrels 6410 | [Selecion 6030068 [5nap-To Oif]

Reversa 4

You should now see a gentle slope at the start of the track.
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Removing Blemishes

If the track contains a cough or other such noises it may be good to remove it. There are
four ways to do this; either chop the blemish out of the track entirely, reduce the volume of
the blemish, replace the blemish with silence (or white noise) or if there is significant
background noise meaning the first three options are not suitable, replace the blemish with
some background noise copied from elsewhere within the sound file.

There is a temptation to remove all coughs and blemishes throughout the track. Firstly, this
is a lot of work as you have to trawl through the whole track and find each blemish in turn.
Secondly, if the edits are not done properly, the track can sound artificial or unprofessional.
The recommendation is to only remove major problems and leave other minor "venue
noises" in the track - after all, they were part of the event.

To chop out the blemish, first select the appropriate area of the sound file.

= Audacity =Bl
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Zoomn
Projectrete: 44100 | [Seiection’ (:01 605803 - 0:02 012580 (1100 206077 minvsec) [Snap-To O]

You may like to expand the resolution to make selection easier. This is achieved by using
the ‘Zoom In’ facility which is a magnifying glass containing a ‘+’ sign.
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Then delete the area with the 'Delete' button on the keyboard.

The second method is to reduce the volume; this may give a more natural flow to the track
than simply chopping out the blemish. To do this, select the blemish (as described above)
and then choose ‘Amplify’ from the ‘Effects’ dropdown menu. Move the slider to the left to
choose a negative value and press OK.

To see if you have fixed the problem, play back the track and listen to see if the new volume
is suitable. If you have reduced the volume too much then undo the effect and try again
with less severe setting. If the cough is still too loud then repeat the operation.

= Audacity _ T =[]
T

BT I

oY

R IRL i
) J ) ) '1!)@4 42-3630-241312 Eﬂﬂmuﬂiﬁm-ﬂﬁ ﬂﬁl)
Crkx
o @l—_l [ @ [ [o]] 2 2]2]2
CrHw PRy
CrHT

s Trim

Delste ChrH
Sience i

Spilt

. Duplicate vk

Select.., »
Find Zero Crossings 2

Sealection Save
Selection Restore

_ Move Cursor.., >
|[pisks  Snap-To... * |24 rines
(PR proferences.. | ubp |- 002012680 (000208077 mivses) fSnep-To o] . ’JJ

The third method is to replace the offending area with silence (or white noise). Select the
blemish as described above. Then select ‘Silence’ from the ‘Generate’ drop down menu.
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Accept the default length and press OK.
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If the silence sounds wrong then try replacing the blemish with white noise. You will
probably need to reduce the volume of the generated noise until it fits in with the rest of
the track. This will involve a bit of trial and error although you should be able to judge the
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approximate volume by looking at the sound file.

The fourth method is probably the trickiest approach to use and should only be used if the
previous methods have failed. First of all, determine the length of the blemish; you may like
to Zoom In to make sure your calculations are as accurate as possible.
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In this case the blemish lasts 5.35-4.70 secs = 0.65secs. Now copy 0.65secs of ambient
background noise from elsewhere in the track - do this by selecting an area and then use
the ‘Copy’ button.
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Then select the area you want to replace and pres's the ‘Paste’ button.
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The finished track should now have the blemish removed. You should listen to the section
that was replaced to see if it sounds acceptable. You can always undo the changes if the
results are not satisfactory.
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Compression

In a nutshell, 'Compression' (or Dynamic Range Compression) makes the quiet bits of the
recording louder and the loud bits quieter.

It may not be suitable in all situations, especially when the recording contains significant
background noise with big gaps between the louder (spoken) sections. You need to rely on
your ears to make sure that the level of compression you have added is suitable for your
recording.
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Where appropriate, compression is used to give more body to the spoken voice and to

musical instruments such as drums. Compression is probably used on 99% of recorded
material.

Select the whole track by clicking in the left-hand side track information box, then select
‘Compressor’ from the ‘Effects’ menu. Start by moving all sliders to the left hand side

giving minimal compression. To be on the safe side, unselect the ‘Normalize’ option; we will
normalize the track later.

Dynamic Range Compressor x|

Dynamic B ange Comprezzor by Dominic bMazzoni

0 dB
12 dB

24 dB+
36 dB

48 dB
60 dB

60 dB 48 dB 36 dB 30 4B 24 dB A2 dB 0 dB

Threshold: -56 dB

—_
A
—
A

Riatio: 2:1

Altack Time: 0.1 secs i,

[ Momalize to 0dB after compressing

Preview | Cancel | ak I

This should give the recording a warmer feel; you can experiment with other settings using
the ‘Preview’ option.

Remember: There is always the 'Undo' function so don't worry if you think you've
completely destroyed the recording, you can always go back!

Equalisation (EQ)

‘EQing’ as it is called in musical circles, involves boosting and reducing certain frequencies
in the recording. At its most simplest, it can be used to remove rumble and hiss. Rumble is

caused by low frequencies and hiss by high frequencies. It is recommended that for spoken
word recording the following EQ ‘curve’ should be used.

x|
E qualization, by titch Golden & Waughan Johnzon
24 dB
0 dB
24 dB
30 Hz 100 Hz 300 Hz 1000 Hz 10000 Hz
Load Predefined Curve Clear |
Fredefined:
¥ acoustic " MAB ™ Columbia LP
 AES " Decca FFRR Micio ¢ Decca FFRR 73
Rl " Calumbia 78 i~ DeccaFFRR LP
= EMI 73  RCAVictor 1938 RCA Victor 1947
Preview | Cancel | OF. I
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Select the whole track and select ‘Equalization’ from the ‘Effects’ menu. Click on the
left-hand end of the blue line, you will see a small circle is added.

x|
Equalization, by Mitch Golden & Yaughan Johnzon
24 dE:;
0 dB
21 B3
30Hz 100 Hz 300 Hz 1000 Hz 10000 Hz
Load Predefined Curve Clear |
Predefined:
f+ acoustic £ MNAB ™ Colurbia LP
 AES " Decca FFRR Micro ¢ Decca FFRR 78
Rl " Calumbia 78 (" DeccaFFRR LP
" EMITE © RCAVictor 1938 RCA Victor 1947
Prewview | Cancel | Ok, I

Next, click on the blue line directly above the 50Hz marker, do not worry about being too
precise, you can move the blobs sideways later. Now you can drag the first marker
downwards to the -24dB level.

Equalization X|

Equalization, by Mitch Golden & Yaughan Johnzon

24 4B

0 dB 3
24 dB 3

30 Hz 100 Hz 300 Hz 1000 Hz 10000 Hz
Load Predefined Curve | Clear |
Predefined:

f+ acoustic i NAR " Columbia LFP

£ AES " Decca FFRA Micra  Decca FFRA 78
 Rlad " Colurnbia 78 " DeccaFFRR LP
 EMI 78  RCAVictor 1938 RCA Yictor 1947

Prewvigw | Cancel 0k

Repeat the process adding more ‘handles’ to the line. Do this above the following
frequencies: 300Hz, 700Hz, 3000Hz and 10000Hz.
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Equalization x|

E qualization, by titch Golden & YWaughan Johnson

24 dB
24 dB ]
30 Hz 100 Hz 300 Hz 1000 Hz 10000 Hz
Load Predefined Curve | Clear |
Predefined:
¥ acoustic  NAB ™ Columbia LP
" AES " DeccaFFRR Micra ¢ Decca FFRA 78
= Rlad, " Columbia 78 " Decca FFRR LP
£ EMI 78  RCAVictor 1938 ¢ RCA Victor 1947

Prewview | Cancel | Ok, |

Then drag the handles around the top to get the desired shape.

Equalization x|

E qualization, by titch Golden & Waughan Johnson

24 JdB
0 JdB
24 (B
30 Hz 100 Hz 300 Hz 1000 Hz 10000 Hz
Load Predefined Curve Clear |
Predefined:
% acoustic £ NAB ™ Columbia LP
" AES " Decca FFRR Micra  Decca FFRA 78
= Rlad, " Columbia 78 " Decca FFRRA LP
i EMI 78  RCAVictor 1938 RCA Victor 1947

Prewview | Cancel | Ok I

Equalisation may reduce the volume so it may be an idea to increase the volume using the
‘Amplify’ options from the ‘Effects’ menu.

Normalisation

Normalising a track means "making it as loud as possible without adding distortion".
Audacity will analyse the peak volume then boost the amplitude of the wave ensuring that
the peak volume does not exceed the prescribed limit. Remember that we compressed
before so much of the spike will have been reduced anyway.

This is a good trick to use if your recording is quiet and you think it needs to be louder. For
instance, if your recording equipment is not as powerful as you would like it to be, the
normalize function can raise the volume levels to a more audible level. However, it is
important to remember not to raise the levels too much or it will sounds distorted or
‘clipped' so use your own judgement about how loud you want to make your track. Select
the whole track and select ‘Normalize’ from the ‘Effects’ menu.
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Leave the default options and click OK.

Normalize x|

Mormalize by O ominic M azzani

v Femaove any DC offzet [center on O vertically

v Mommalize maximum amplitude to -3 dB

Preview Cancel 0] 4

The recording should now be louder. The -3dB option gives a little ‘headroom’ for further
editing of the track.

Bl fdit Vew Projct Generals Effect fnahze beb
3 e e T [ — |

Tk T —
B 909098 laeas immtm o o

Prosctres 44100 | =1

This is a quick and efficient way of boosting a weak audio recording’s signal to a useable
level. One downside to using this tool is that it will of course boost any background noise as
well.

Other Effects

Audacity has many built-in effects. Have a play - occasionally it may enhance the recording
to add an echo or a wah-wah! Other plug-ins can be downloaded from Audacity site.

'Reverb' may be a useful addition as it can compliment vocal recordings if used
conservatively. Reverb makes a sound appear that it has been recorded in a room with
reflective walls; it adds a variety of subtle echoes which give the impression of space. Think
about how different your voice sounds in a tiled bathroom as opposed to a living room with
furniture and carpets.

It is common practice to record voices in a dampened room (perhaps with curtains (or egg
boxes) covering the walls; the impression of space can then be added later. However, if you
are editing a podcast be careful to use these effects sparingly as they can distort and lessen
the overall sound quality of the recording.
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Saving your project and exporting to a podcast .mp3
format

Obviously it is good practise to save copies of the track as you progress just in case of
unexpected events! The easiest option is to choose ‘Save Project’ (or ‘Save Project As’) from
the File menu. Make sure you save your work in a sensible place and give it a sensible
name.

You probably also want to save the sound file in a format that is able to be played back on
your device of choice. WAV is a ‘lossless’ format; it is a Microsoft Windows format but is
supported on most platforms. MP3 is a compressed format and is very common. Unlike
WAVs; MP3 files can be played back on iPods and similar and can be used for podcasting. It
is roughly one tenth of the size of a WAV and for this reason is the ideal format for delivery
over the web; podcasts should use this format. MP3 files can be saved at different ‘bit
rates’, the higher the bit rate the better the quality and the larger the file size.

Audacity has a bit rate of 128 which is fine, however, a bit rate of 64 will produce smaller
files and may still sound fine. If space is at a premium then you can experiment with
different bit rates. To change the bit rates use the 'Edit' menu, select ‘Preferences’ then
‘File Formats’, the bit rate is at the bottom under ‘MP3 Export Setup’.

Audacity Preferences

Audiol.-"D] Quality  File Famats lSpectrograms] Directories] Interface Kepboard] Mousel

‘when importing uncompreszed audio files into Audacity

' Read directly from the original file [faster)

Uncompressed Expart Fomat

[wey Microsoft 16 bt PCM) |

it [Microzoft), Signed 16 bit PCM

0GG Export Setup
0GG Qualy: | § 0

£
=

[MP3 Export Setup

MP3 Library Yersion:  LAME +3.97 Find Library
Bit Rate: 128 =
Cancel | ok |

Ogg Vorbis certainly has the best name and is another compressed format with better
reproduction than the MP3 format, it is an Open Source standard but is generally not
supported as much as WAV files or MP3 files - maybe one day it will gain in popularity.

If you have more than one sound file, select the one you want to save and choose ‘Export as
..... Form the ‘File’ menu. I would suggest saving as a WAV and also saving as an MP3
which is probably the version that you will use.

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http://www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=8019

Contributors: Bjoern, OLewis, PeterRobinson
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Publishing
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Publishing a podcast

Before users can listen to your podcast it requires some means of publication. The most
common way to publish a podcast is by using an RSS syndication feed, which is a special
file that points to the podcast (the MP3, MPEG4 etc.) and contains your description of the
podcast's content.

To publish a podcast the author needs the following:

1. Web space to store the podcast (MP3s etc.) online.

2. An RSS generator, such as a third party service or your University's newsfeed service to
point to the content.

3. A medium to view the podcast (commonly iTunes but there are many other digital media
players and browsers, such as Miro and Firefox).

RSS -Promoting and syndicating a podcast item

To avoid podcasting in a void, podcasts are promoted (advertised, and listed in searches)
using Really Simple Syndication (RSS) for news feeds. Each feed is a simple XML file
containing textual information about the content e.g. title and the URL of the online content
it links to. The information about each item not only includes the title, author and
description of each individual podcast, but also whether it belongs in a series, and what
number in the series it is. Software like iTunes picks up the RSS information and displays it
to the user so they can view, subscribe and download the podcast in the easiest way
possible. Software that can pick up and view RSS feeds are known as aggregators.

OXITEMS A typical RSS Service

OXITEMS is a typical RSS newsfeed system developed at Oxford University by Oxford
University Computing Services. It allows Oxford users to add and maintain news items
(announcements, news, events, podcasts etc.). These feeds can be subscribed to by digital
media players allowing the end user to receive news updates, podcasts etc. without the
need to keep visiting the originating web site themselves.

The first publishing step the author has to make is to upload the podcast to their online web
space, e.g. a college server, their users web space or to a course area on their VLE. You
cannot upload files to OXITEMS as it is not a filestore, nor are other RSS feeds; they merely
link a news item in a newsfeed to an assocated file (called a enclosure) and contain textual
information about this linked file (metadata). Once the location of the podcast is known,
there are a series of easy to follow web-based forms into which you fill in the information.
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Contact

OXITEMS manages news items for display using RS5/Atom

Add an item

oucsfemergency: OUCS Emergency News ~
oucsfits3-news: [T Support Staff News

oucsitg-podcastdemo: LTG Podcast Demo feed

oucsfiig-websitenews: News about LTG

oucs/news: News from Computing Serices

oucsfregistration-update: News from Registration

oucsfrs-update: News from the OUCS Research Technologies Service
oucsfservices: OUCS Services v

| {add an tem to the selected newsfeed| ‘

Contact OUCS | Feedback | Help page | Use old style search | @ University of Oxfo

Adding your podcast to a RSS feed service
Each RSS service is slightly different but the following steps are typical -

1. Login. You will now see a list of the podcasting feeds that you are eligible to add new
items to. If not you may need to create one.

2. Select the podcast feed you wish to add to and click the Add New Item to Selected
Newsfeed button.

3. You will now see the Add an Item screen. This is composed of various boxes where you
need to add in information about your new podcast. This must include the URL (location
on the web) of your podcast file. Complete the form as instructed. Cataloguing fields
needed include:

e Title
¢ Description
e Author
¢ Duration
* Rights and permissions tick box

4. Submit podcast information form

5. You will now see a summary of your entries. If these are all correct, click the Now Add
the Above Item to the Newsfeed button. If you need to make any changes to the form
entries, click the Make Changes to the Values of the Above Item button instead. You will
be returned to the original form where you can make edits to your entries. Submit again
and check your the summary of your entered details

6. Once you have submitted your item, your service should show you a new page showing
all the items in the feed. Your new item should be at the top of this list. You will also be
give the URL of the RSS feed into which you have added your podcast item. This URL is
the one to place on your own web pages.

Accessing your podcast feed

In order to check whether your podcast feed and files work on the web you need to
subscribe to the feed and download the file(s) in question. These instructions relate to using
iTunes to check the feed. If you do not have iTunes already, visit http://www.apple.com/
itunes/ to download the program. Install this onto your computer. If you do not want to
install iTunes onto your system, you can also check the url of the feed using modern web
browsers such as Firefox and Opera. Alternatively there are other digital media players
available that you can use instead.

1. Open iTunes and click on [Advanced] found on the top most menu. "Advanced" button
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2. From the dropdown menu select [Subscribe to podcast] option. A new dialogue box will
appear. "Subscribing to a podcast, type URL here"

3. Enter the address of your podcast feed i.e the URL given to you via OXITEMS or
another RSS service. Click on OK

4. iTunes will now access the RSS feed and list any items it finds in the main iTunes
podcast screen. "Podcast shown in iTunes podcast”

5. Each item in the feed can now be downloaded either individually by clicking the Get
button by each one, or by clicking on Get All next to the name of the feed itself.

6. Click the Get button next to your new item. iTunes will access and download the file to
your machine.

7. Once your file is downloaded, the podcast title will change to black text and the Get
button will disappear. You will now be able to play the podcast in iTunes.

Note that once you've subscribed to a podcast feed you wil see automatically in the client
whenever new material is available for downloading. This syndication element is the key
reward of RSS podcasting.

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http://www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=7995

Contributors: Barry.cornelius, Bjoern, OLewis, PeterRobinson

Tutorials/Encoding mp3 with iTunes

This tutorial explains how to encode to mp3 using iTunes 7. Some notes inline below for
changes in iTunes 8.

Setting up preferences

Setting up preferences

mFile Edit Controls

About iTunes
iTunes Hot Tips

Preferences... #,

Shop for iTunes Products
Provide iTunes Feedback
Check for Updates...
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Select '‘Advanced’' and 'Importing'

Advanced

DN P o BE & u LB

General Podcasts Playback Sharing Store Advanced Parental aApple TV Syncing

GE.Hi.:raI.- Importing Burn.ing l

On CD Insert:  Ask To Import CD _:]'
Import Using: MP3 Encoder _:]
Setting: GCood Quality (128 kbps) _:!
Detalls

B4 kbps (mona)f 128 kbps (sterea), joint stered,
optimized for MMX /S5E, using MP,

Note: As of iTunes 8 this dialog is under the very top left 'General' tab. Use the 'Import
Settings..."' button to access the settings.

Under setting, select 'Custom’

Setting: | + Good Quality (128 kbps) E]
High Quality (160 kbps)

Higher Quality (192 kbps) ;mn

Custom...

Select bit rate = 64 kbps, Sample rate = 22.050, channels
= Mono

MP3 Encoder

Stereo Bit Rate: 64 kbps _ﬂ

__ Use Variable Bit Rate Encoding (VBR)
ol 1

(With VBR enabled, Bit rate settings are used for & guarartesd rinimum Bit rate.)
Sample Rate: 22.050 kHz :!

Channels: Mono _ﬂ

Stereo Mode: MNorma
E Smart Encoding Adjustments

™ Filter Frequencies Below 10 Hz

Use Default Settings (" Cancel @

We are selecting the Sample rate as 22.050 so that the audio plays back properly in Flash
players.
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Click 'ok' -the preference pane should now look like this:

Caneral IFrEing Burning

On CD Insert: | Ask Te Import CD |

Impart Using:  MP3 Encoder

Setting:  Custom

Derails

12 kbpd imongd, 44,100 kHE, mono, optimited
T WEMER PSS, uiing MP

Now switch to general, and uncheck 'copy files to iTunes
Music folder"

F—ﬂ : -
' General Importin Burnin
P 9 - g __ Copy files to iTunes Music folder when adding to

Note: In iTunes 8 although the General/Importing/Burning selection is gone from this tab
you will still find the 'copy files to iTunes music folder' setting here.

Encoding files

Drag your aif/wav file into iTunes.

Amend meta-data: Hit Apple-i (or 'Get info') and amend fields like author, title, description
etc.

Select 'Convert selection to mp3'. Drag the file out of iTunes (e.g. onto the desktop) and
amend the filename to be suitable for distribution. You might then want to drag the file
back into iTunes to check the metadata and to make sure the filename appears as expected.

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http:// www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=7901

Contributors: Bjoern, OLewis, 6 anonymous edits
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RSS and Atom newsfeed formats

Various formats are often used for newsfeeds (including podcasting newsfeeds). The
formats that are considered here are: RSS 1.0, RSS 2.0, Atom 0.3 and Atom 1.0.

A validator

There is a validator that can be used to check the validity of a newsfeed that allegedly
conforms to one of these specifications. This validator is at http://feedvalidator.org/

Departments and colleges at the University of Oxford use a newsfeed generation system
called OXITEMS. We have extensively used the validator to check out the validity of the
RSS 1.0, RSS 2.0, Atom 0.3 and Atom 1.0 newsfeeds that are generated by OXITEMS. The
feedvalidator software is open source, and can be downloaded and run locally. We have
downloaded a copy and every 4 hours we use it to check the validity of the newsfeeds that
are used by Oxford's site in iTunes U.

Note: if you attempt to validate an Atom 0.3 newsfeed using this validator, it will report the
newsfeed is an obsolete version. It says that early adopters of the Atom format should
upgrade their feed to the latest version of the specification.

RSS 1.0

The RSS 1.0 specification is at http://web.resource.org/rss/1.0/spec

The description element (of an item) is described as (#PCDATA). Consequently, there is no
explicit provision for including HTML markup in a newsfeed.

Extensions to RSS 1.0 is done through the use of modules. A page containing a list of
proposed modules is at http://web. resource.org/rss/1.0/modules/proposed. html. For
example, the module for events is at http://web.resource.org/rss/1.0/modules/event/

RSS 2.0

Although the numbering may imply that RSS 2.0 is a more up-to-date version of RSS 1.0,
this is not the case: there has been an unfortunate forking in the development of RSS and
an unwanted confusion re numbering. So RSS 1.0 and RSS 2.0 are alternative and rival
newsfeed formats.

Athough there is a version of the RSS 2.0 specification at
http://blogs.law.harvard.edu/tech/rss, since July 2003, the RSS Advisory Board has been
looking after revisions. The latest revision of the RSS 2.0 specification is at http://www.
rssboard.org/rss-specification

The specification does not seem to specify what the description element can contain. Some
people say that it can contain HTML; whereas others say that it definitely cannot.
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For example, a web page at Mozilla (http:/ / developer. mozilla. org/ en/ docs/
RSS:Article:why RSS Content Module_is Popular - _Including HTML Contents) says Do not
put anything but plain text into the RSS <description> element. Although it has become
common practice to abuse the RSS <description> element and put non-plain text data in it.
It is not actually allowed.

However, some people do put HTML into the description element.

When using RSS 2.0, you are allowed to use elements from other namespaces. So, other
people use a content:encoded element instead of a description element for providing
HTML. Some people even provide both with HTML in both.

YAHOO use RSS 2.0. In the description element, they put HTML inside a CDATA section. An
example is http://rss.news.yahoo.com/rss/sports. This method is also adopted by other
people.

The Mozilla web page cited above says that CDATA sections reduce the bloat. However, the
<description> is NOT suppose to be used for any of this. It is only suppose to be used to
include plain text. They say that HTML should be put in a content:encoded element.

The BBC uses a mix of RSS 2.0, RSS 1.0 and RSS 0.91. For their RSS 2.0 feeds, they just
put a single sentence (using no HTML) in the description element. An example is http://
newsrss.bbc.co.uk/rss/newsonline_uk_edition/front_page/rss.xml

Date elements such as pubDate and lastBuildDate require use of the RFC 822 format for
dates. This format is not easy to parse, and in my opinion, it is preferable to supply dates in
the ISO 8601 format. Some people use a dc:date element instead of a pubDate element.
This requires the use of ISO 8601.

RSS 2.0's author element requires an e-mail address. Because it is considered to be bad to
disclose e-mail addresses in newsfeeds, OXITEMS uses:

undisclosed email address@ox.ac.uk (Fred Bloggs)

This format is valid according to RFC 2822 but it is regarded as a legacy format by RFC
2822. However, it is the format illustrated in an example in the RSS 2.0 specification.

Other people omit the author element and use a dc:creator element instead. If you try using
both, the validator will moan that this is not allowed.

If you want to use RSS 2.0, instead of using pubDate, description and author, you could use
dc:date, content:encoded and dc:creator. This is valid RSS 2.0 but this use of elements from
other namespaces for the crucial elements suggests the RSS 2.0 format is inadequate.
Although the use of these other namespaces in this way is quite common, it is unclear as to
how many newsfeed readers support the use of these other namespaces.

As mentioned above, RSS 2.0 permits elements from other namespaces. So the RSS 1.0
modules mentioned earlier can also be used in RSS 2.0. Here, again, is a link to a page
containing a list of proposed RSS 1.0 modules: http:// web. resource. org/ rss/ 1. 0/
modules/proposed. html. One such module is the module for events: http://web.resource.
org/rss/1.0/modules/event/.
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RSS 2.0: Apple iTunes and iTunes U formats
The additional elements used by Apple for iTunes are documented at http://www. apple.
com/itunes/store/podcaststechspecs.html

iTunes U uses an additional element, an itunesu:category element. This element is
documented at http:/ / deimos. apple. com/ rsrc/ doc/ iTunesUAdministratorsGuide/
iTunesUintheiTunesStore/chapter_9_section_2.html

Atom 0.3

The Atom 0.3 specification is at  http:/ / www. mnot. net/ drafts/
draft-nottingham-atom-format-02.html

Note that with the release of Atom 1.0 during Summer 2005, Atom 0.3 is deprecated. The
above web page says the Atom 0.3 specification is made available for historical purposes
only. It continues by saying DO NOT implement it or ship products conforming to it.

The Atom 0.3 specification says that content elements MAY have a "type" attribute, whose
value indicates the media type of the content and if this is not present, its value MUST be
considered to be "text/plain". The specification also says that content elements MAY have a
"mode" attribute, whose value indicates the method used to encode the content. This can be
one of the values "xml", "escaped" and "base64". If [it is] not present, its value MUST be
considered to be "xml".

Typically, people have content elements like:
<content type="text/htm!" mode="escaped"> ... </content>
And inside the content element, people:

(a) either put HTML inside a CDATA section as shown at http://gilbane.com/blog/atom.
xml

(b) or they provide encoded HTML writing
as & It;p& gt; as shown at http://ramble.oucs.ox.ac.uk/blog/stuart/atom.xml.

Atom 1.0

The Atom 1.0 specification is at http:/ / atompub. org/ 2005/ 08/ 17/
draft-ietf-atompub-format-11.html

Atom 1.0 was released during Summer 2005. There is a useful summary of the changes
between Atom 0.3 and Atom 1.0 at http://www.rakaz.nl/nucleus/item/103

Atom 1.0 has title, summary, content and link elements. The content element has an
associated type element which can be "text", "html" or "xhtml" or any mime type.

A good article on the topic of guids is "How to make a good ID in Atom" by Mark Pilgrim:
http://diveintomark.org/archives/2004/05/28/howto-atom-id

A good overview of Atom 1.0 is: http://www-128.ibm.com/developerworks/xml/library/
x-atom10.html
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Support by newsfeed readers

Firefox 1.5 has support for live bookmarks for all of the above four formats. The previous
release (Firefox 1.0.7) had no support for Atom 1.0. Plans for Firefox 2.0 and 3.0 are
outlined in http://wiki.mozilla.org/Feed_Handling

With Thunderbird 1.5, it is possible to read RSS newsfeeds and Atom 1.0 newsfeeds. The
previous release, Thunderbird 1.07, can only read RSS newsfeeds.

Although Internet Explorer 6 has no support for RSS and Atom newsfeeds, IE 7 has support
for (at least) RSS 1.0, RSS 2.0, Atom 0.3 and Atom 1.0.

Although Opera 8 has support for RSS and Atom 0.3, it has no support for Atom 1.0.
Support for Atom 1.0 is available in the latest development release of Opera (Opera 9.0
Preview 1, released on October 20th 2005).

iTunes software is a useful tool for testing a podcast newsfeed via the Subscribe to Podcast
function.
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The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http://www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?oldid=8135

Contributors: Barry.cornelius, Bjoern, OLewis, PeterRobinson
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Institutional Podcasting
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Institutional Checklist

The following checklist may help you in planning work at an institutional level to provide a
podcasting service or to improve current activities.

Overview

How would you summarise your institutional approach to podcasting ? Is it a centralised
activity or localised to departmental activity ? How do people find online audio-visual
material at your institution? Do you have a central web page or through Google ? It may
help you to start to create an overview of your setup and situation, list institutional
priorities and start to note down the the overall processes for material being created and
the different types of material that might be created - outreach, teaching, research etc. The
following questions will help add more depth to any summary of activity.

Institutional Podcasting

¢ What do you see as the primary benefits of podcasting?

* What teams/personnel are involved at your institution in podcasting?

¢ What are their roles in the process?

* How much of their time is dedicated to those podcasting tasks?

* Who has overall management/responsibility for podcasting?

* Are there steering groups involved at any level and where do they draw their
membership from?

* Where are the major costs incurred?

* What areas do you see as having opportunities for cost savings/efficiencies?

* What technical areas could be advanced?

* What technical areas are currently problematic?

* What are the top 5 risks to your podcasting processes, and their solutions?
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Audio Video Capture

This section is focussed upon the initial digitisation and content production aspects.

What material are you targeting/getting (both academic and non-academic areas)?
Who is responsible for sourcing the material?

Where do you capture the material?

How is the material captured/digitised (differs for lectures, interviews, outreach, etc)?
Where/how is that source material stored?

What metadata is captured to accompany the media?

How do you record the metadata and when?

Content Processing

This section looks at content issues from post digitisation to final published outputs.

What editing work is done to the original material?

Who does the editing?

How much time is spent on editing?

What guidelines are provided for editing (e.g. times, focus, styling, titles)?
What software/hardware is available for editing, and who has access to it?
What outputs do you have from the editing process?

What compressed formats do you support, and why?

Who does the compression for published work, and what do they use?
What metadata is added to the final outputs?

Content Publishing

This section is concerned with the practicalities of distribution and syndication methods.

Where do you publish your podcasts to?

Who provides the public webspace for published material?
What does they use to provide this service?

How much resiliency is built into the file hosting system?
How are files placed on/in this webspace?

How much space do you presently have available, and what was the criteria for this
quantity?

What do you use to provide the published RSS feed?
Who/what is responsible for data entry to the RSS system?
When do you create the feed?

Who/what consumes that RSS feed?

Do you offer other forms of syndication?
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Content Management

What aspects of the podcasting process do you control/manage?

Do you have a central authority for podcasting?

When do you first learn of new material?

Who is responsible for content on each of your distribution systems?
Do you plan/schedule content for release?

How do you track the status/progress of podcasts within your service?
Do you have an automated/digital system for content management?
How do you identify content within your processes/systems?

Do you host or surface your material in a third party service?

Who is responsible for maintaining your iTunes U/YouTube interface?
How do you update your iTunes U/YouTube interface, and how often?

Storage

What elements of the podcasting process do you store?
What methods/systems do you use?
How long do you store the material for?

Quality Control

Do you maintain any standards for published material?
Who checks that these standards are met?

Where in your processes is Quality Control done, and how is it implemented/enforced?

Legal

What legal responsibilities do you have in regard to podcasting?
How do you ensure those responsibilities are met?

What release/consent forms do you use?

How do you administer the legal processes?

What problems to you encounter administering these processes?
What is your take down policy?

Marketing

Who is your target audience ?

Have you considered a press release or discussed a communication plan ?
What channels do you have to communicate with your key audiences ?
How will you track usage?

How will you evaluate wether your marketing strategy is working?

Source: http://www.ict4e.net/wiki source/index.php?oldid=7503

Contributors: Bjoern, PeterRobinson
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Institutional Podcasting: Suggested Project
Workflows

Introduction to common elements of a workflow

In order to save time while managing work and help a team follow a plan, an agreed
workflow is vital. This is especially true for teams dealing with a large amount of
digitisation activity. A written workflow helps a project where there are many staff handling
content and working with many complicated subprojects. Regardless of your specific
processes for handling AV projects at an institutional level, there are common workflow
elements required to allow files/projects to be located easily and efficiently.

It is also important to start to think of multiple encodings per project to be handled so that
different online versions can by provided. Users with greater infrastructure resources
(more disk space, higher bandwidth, better players, etc) will appreciate downloading the
higher quality versions. Whereas, those with less infrastructure resources will prefer the
time saved by having access to smaller files.

To simplify the number of derivative versions needed by users, it is recommended to
produce a limited range of different quality versions for different distribution uses. As well
as the Master Edit version of the video content, there are four levels of encoded output for
video podcasts and three levels for audio using this simplified workflow. These are outlined
in the following tables.

Sample settings for encoding video

Level Filenames Resolution Encoding details Typical
file-sizes

Master filename.dv or filename.mov 4:3 = Not defined, 16:9 | DV or Uncompressed ~ 12000Mb/h
Edit = Not defined
High filename-high-video.mp4 4:3 = 640 x 480 px, 16:9 | Bitrate: VBR using VBV | ~ 690Mb/h

= 640 x 360 px @ 1500k. Peak 1800k.
Medium filename-medium-video.mp4 4:3 = 640 x 480 px, 16:9 | Bitrate: VBR using VBV | ~ 350Mb/h

= 640 x 360 px @ 700k. Peak 900k.
Low filename-low-video.mp4 4:3 = 320 x 240 px, 16:9 | Bitrate: VBR using VBV | ~ 150Mb/h

= 320 x 180 px @ 300k. Peak 450k.

Key things to note:

e The three levels (high, medium, low) all share these Encoding attributes: H264 encoded.
Keyframes: Natural and Forced (every 20 frames). No. Of Reference Frames: 1. Profile:
Baseline. B-frames: 1.

* For playback on iPods and similar media devices, a Baseline encoding profile is
essential.

* For H264 files to support “scrubbing” (winding forwards and backwards through the
video) you need to supply a good dose of keyframes at regular and frequent intervals.
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Most encoders support automatic scene (natural) changes and insert a keyframe there.
However, video that doesn’t feature much movement (e.g. talking heads, lecturer at a
lecture, etc) tends to feature few keyframes. Our value of 20 frames between keyframes
is almost arbitrary, but aims to compromise between recovery gaps (how long it takes the
player to refresh an image between keyframes) and compression. It does mean that any
artifacts introduced by interrupted or skipping of playback should be fixed in under a
second.

Audio Encoding

Sample settings for encoding audio

Level Filenames Encoding details Typical file-sizes
Master Edit filename.aif or filename.wav Uncompressed, PCM, 16bit, 44100Hz, |~10Mb/m
Stereo ~600Mb/h
Medium filename-medium-audio.mp3 Lame MP3. VBR 64-(128)-320k. ~780Kb/m
44100Hz. Joint Stereo. Stereo output ~47Mb/h
Low filename-low-audio.mp3 Lame MP3. VBR 32-(32)-96k. 44100Hz. | ~380Kb/m
MS Stereo. Mono output. ~23Mb/h

At present the high quality audio version is identical to the master/archive copy.

Consistent Naming Strategy

Whatever approach followed, a common naming strategy is needed. Due to the disparate
systems underlying the work done, the need for human readable project names applied
consistently is required to allow content to be located and tracked. There are primarily
three distinct systems/locations to consider:

* Local filestore
* RSS
* media.podcasts.university.ac.uk

Generically, naming takes the following pattern: /unitcode/project name without spaces

What is a project? This is a valid question, not easily definable. Crudely, any set of related
podcasts/media-files and their source materials. Thus a working project folder will contain a
range of media and text files related to that work/topic. Folder paths and names should be
identical on both Local filestore and media.podcasts, with RSS feednames mirroring the
folder/project name. These folder names and file names will eventually form part of a public
URL, and thus should be human readable and sensible in appearance.

Local Filestore

The main working copy of a project should be held in an accessible (to all users that need it,
opposed to on your local user desktop) area, ideally grouped together in a common folder
(e.g. Projects). Once in that folder, next level should be folders bearing unitcode names
(e.g. UnitX,UnitY, SubjectAreaX, SubjectAreaY, etc) and that then contains a project folder
with a unique (short) name. A project folder should contain a number of consistent
elements (folder name in brackets):

¢ Unmodified source material (Originals)
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¢ Legal documents and notes (Legal)

* The final edited master files (MasterEdit). Naming of these files needs to be done in a
short and sensible fashion as their name will be carried onto the published files (with
suitable appendices and file extensions). There should be NO SPACES in these names. If
needed, use an underscore (_) character in place of a space. This is a derived from
simplifying issues related to URL names and paths.

» Final set of encodedl outputs made from the contents of the MasterEdit folder
(FinalOutputs)

* A number of folders containing working edits, partial material, project files, tests, etc.
These can take a range of names to suit whoever is working on the material.

As a rule, we are not deleting any temporary work or test files. Whilst space allows we are
moving these to “Junk” folders in the relevant section of the project folder (i.e. there can be
multiple junk folders in a project folder). If at some point storage space becomes critical, a
sys-admin may target these folders for deletion.

Thus we can have....

/Projects
/unit
/project alpha
/0riginals
/some_input.mov
/Legal
/ApprovalForm.doc
/MasterEdit
/Junk
/project alpha oldedit.dv
/introduction.dv
/introduction.aif
/FinalOutputs
/introduction-low-video.mp4
/introduction-medium-video.mp4
/introduction-high-video.mp4
/introduction-low-audio.mp3
/introduction-medium-audio.mp3
/Freds working edits
/clipl.mov
/clipl 2-too-short.mov
/alpha.imovie-project
/another project
/0riginals
/Legal
/MasterEdit
/FinalOutputs
/another-unitcode
etc..
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A central online filestore: media.podcasts

The centrally hosted publicly available online filestore is referred to as media.podcasts. The
accessible URL for the public portion of the filestore is http://media.podcasts. university.
ac.uk/. There are two top level folders in this example: archive and pub. The aim is to copy
portions of the local filestore in both the [archive] and [pub] folders, thus under all three we
should see a series of folders representing the unitcodes, and in those folders the project
folders, and in those folders, files. However, we are only interested in copying the files
encoded for public consumption to [pub] and just the master edit files to the [archive] tree
(as we can regenerate the processed content from these if needed). Thus, using the
previous example we would have (for a special video project with three feeds - see RSS
section):

/media.podcasts.university.ac.uk

/pub
/unit
/project alpha
/introduction-medium-video.mp4
/introduction-high-video.mp4
/introduction-medium-audio.mp3
/another project
/archive

/unit
/project alpha
/introduction.dv
/introduction.aif
/another project
etc

The key here is that the RSS will point to the files in /pub/unitcode/projectname/.

RSS

RSS does not support more than one media enclosure per item. It's thus not possible to
include both an audio and video file in the same item (with just RSS). However, in RSS 2.0
additional namespaces are supported, and the yahoo media namespace can be used to add
multiple enclosures per item. Atom, a newer format, also has the ability to have several
‘enclosures' per 'item', i.e. several <link rel="enclosure"> tags per <entry>. Further
information and comparisons can be found here: http:/ / en. wikipedia. org/ wiki/
Enclosures_in_yahoo_media%?2C rss%2C _and_atom.

If you have a system that doesn't support multiple enclosures, you have have to create a
number of RSS feeds for each project delivery format. Similarly, if you are delivering
content for iTunes U then each RSS feed appears as a tab in an iTunesU entry for a
project/topic. This might range from 1-4 RSS feeds per project.

1. Audio only

2. Video

3. For special projects - audio, video & high quality video

4. Transcript pdf
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RSS Feeds need to be created using the common naming strategy which starts
“unitcode/project name” and is then appended with:

“-audio” for the audio only feed “-video” for the standard video feed “-high-video” for the
high quality video feed

Thus the project “another project” for “unitx” becomes the following feeds...

unitx/another project-audio
unitx/another project-video
unitx/another project-high-video

It is also possible that files generated in this project can be referenced by other RSS feeds,
but that doesn’t imply there is a matching folder structure for these meta-feeds. Once these
feeds are created, individual media items have to be added to each feed, so for each
episode in your podcast stream there will be up to three media items created (individually
and manually) for the corresponding encoded file. A project may decide to use a smaller set
of available media for instance only the following encoding outputs may be in the core set
of institutional newsfeeds:

* RSS feed -> Encoded File in the enclosure

* projectname-audio - > projectname/filename-medium-audio.mp3

* projectname-video - > projectname/filename-medium-video.mp4

* projectname-high-video - > projectname/filename-high-video.mp4

Source: http://www.ict4e.net/wiki source/index.php?oldid=8101

Contributors: Bjoern, Marshalc, PeterRobinson
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Podcasting Tasks and Dependancies

The following diagram is a chart of tasks involved in podcasting at an institutional level and
a series of dependancies that define their ordering. Not all tasks are essential nor do you
have to start at task 1 - the latest entry point is likely to be task 13. This chart is not linear
and the arrows indicate dependancies - tasks point to tasks that are dependant upon them
completing before they can complete. Most tasks can run concurrently.
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Whilst this collection of tasks is not exhaustive, this does help to clarify some of the main

steps taken to get a podcast from conception to delivery.

Let us briefly work through the tasks, but from delivery to conception
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31 - To be able to manage or report on your podcasting you need statistics such as the
number of downloads for a given piece of content, who and where your audience are
located and their usage patterns.

30 - Ultimately the aim is to have the content downloaded by subscribers or ad-hoc
users.

29 - To take full advantage of podcasts subscribing to the feed is a key user task.

28 - It is possible that you will need to be able to remove podcasts from within your
system.

27 - Publishing the podcast and feed to Apple iTunes U is a simple technical process that
yields exposure to a captive worldwide audience.

26 - Including tasks 25, 24 and 22 this relates to the quality control aspects included in
the Apple iTunes U contract and due diligence on behalf of the institution. This final step
is the last check before material is made available for inclusion within iTunes U.

25 - Quality control task looking at playback issues for the content.

24 - Within our devolved system responsibility for content quality and copyright and
permission ultimately fall upon the sponsoring department and a nominated
representative.

23 - Participants may need to review publishable outputs, often before they will consent
to public release.

22 - All speakers within a podcast sign a release form permitting the university to use
their recording.

21 - Preview the content may require a copy on DVD or CD (or via private network) so
that the presenter and sponsoring department can review.

20 - Another outlet for publishing is the institutional web portal...

19 - ...As well as publishing the content locally on a related project/subject specific
website.

18 & 17 - This two stage process requires 17 (Creating a Podcasting Feed) if this new
content does not belong in another existing container, and 18, the actual creation of an
RSS metadata record that can be published within the podcasting feed. Publishing the
URL allows users to subscribe for automatic downloads of new content.

16 - Part of the metadata related to items and feeds is that of a visual icon, or Album Art.
Typically this is a square JPEG/GIF/PNG image around 300px by 300px.

15 - Early on in the process you can begin collecting the metadata that will be associated
with the content. This may be as trivial as a Title and Presenter, but can encompass a
much wider range of data fields.

14 - Processed content needs to be uploaded to a website for hosting and distribution.
Combining the URL to access the content with the metadata (15) and album art (16) in
tasks 17 & 18 is what effectively creates a "podcast".

13 - Processed content refers to final edits of a piece of content compressed down into a
suitable format for distribution. These file(s) will need to be stored somewhere, likely
before they are uploaded to their final hosting location.

12, 11, 10 & 9 - These four tasks collectively describe automated activities that
transform a final edited piece of content into a set of files suitable for final distribution.
Less work is typically done on audio only content (12) than on video, where resizing of
content and combining it with a suitable marketing trailer/short-movie is followed by the
compression stage.
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* 8- For many systems, the starting point is receiving a large, high quality version of the
content to be published. Typically this content will need archiving for security and reuse
purposes.

* 7 & 6 - To produce effective and high-quality content a level of editing is usually
required. The degree of work done at this stage is highly dependant on your aims,
resources and constraints.

* 5 - Podcasters will typically want to keep a copy of their original material, as at later
dates, alternative editing may be desired.

* 4 - Whilst many will now use technologies that automatically produce digital content
from the recording process, there is a need (for example with historical content) to
convert analogue formats to digital media.

* 3 -The act of creating content is the recording of a performance/presentation.

e 2 - If you have resources that can be used by podcasters to aide their work, this step
accounts for that activity.

* 1 -To aide planning (such as media calendars etc) it helps to know what material may be
making an appearence within the final output systems. This step acknowledges that you
can start to track this content even before an actual recording is made.

Depending on the degree of centralisation and the levels of support your institution may be
able to offer, is the number of entry and exit points for the different stakeholders within this
process. Not all podcasts flow from task 1 through to 31 and those providing or supporting
these users should be aware that surprise additions can appear out of the woodwork as well
as promising content being withdrawn due to lack of consent, and a variety of other
scenarios.

We hope you will find this useful as a discussion document as well as a starting point to
compare with your own processes.

Source: http://www.ict4e.net/wiki source/index.php?oldid=8086

Contributors: Bjoern, Marshalc, OLewis, PeterRobinson
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Further resources on the web

Tutorials/Links

Other resources on the web:

Guides

JISC Digital Media Guides - http://www.jiscdigitalmedia.ac.uk/site-map/

JISC Digital Media Guide to Microphone usage - http://www.jiscdigitalmedia.ac.uk/
audio/advice/microphone-technique/

VideoAktive resources, http://www.videoaktiv.org/index.php?id=40 (in particular the
Handbook on Digital Video and Audio in Education - Creating and using audio and video
material for educational purposes, http://www.videoaktiv.org/index.php?id=233)
Accessibility multi-media chapter in web-design guidelines http://www.aptivate.org/
webguidelines/Multimedia.html

Also, for network managers, the BMO book (for free) from here http://www.bwmo.net/
. ( a great resource for network managers, aimed at developing world use.)

Pdf downloading report from Aptivate (2005) http://www.aptivate.org/Projects.
PDFDownloadingGuidelines.html

Five Steps to Multimedia Recording from Berkeley, http://journalism.berkeley.edu/
multimedia/

iPod in Education website, http://www.addysg.org.uk/ipodined/news.php

University of Leicester podcasting guide (wiki), http://www2.le.ac.uk/projects/impala/
impala-wiki/CreateAPodcast

IWMW Workshop on Podcasting, http://www.ukoln.ac.uk/web-focus/events/
workshops/webmaster-2006/sessions/ramsden/

IWMW podcasts evaluating podcasting, http://www.ukoln.ac.uk/web-focus/events/
workshops/webmaster-2005/podcasts/

IWMW introduction to podcasting through a collaborative learning lens, http://www.
ukoln.ac.uk/web-focus/events/workshops/trieste-2005/talk-2a/

Steeple Project Podcasting Scrapbook, http://steeple.org.uk

Placing Oxford on iTunesU, http://www.oucs.ox.ac.uk/podcasts/presentations/
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Podcasts in education

Podcasting for Pedagogic Purposes - a UK community podcasting SIG, http://
podcastingforpp.pbwiki.com/

Impala Podcasting project based at Leicester - http://www?2.le.ac.uk/projects/impala/
Apple iTunes for Higher Education, http://www.apple.com/education/itunesu/
CamTV, http://mediaplayer.group.cam.ac.uk

Oxford on iTunes U, http://itunes.ox.ac.uk

Open University, http://itunes.open.ac.uk

UCL, http://itunes.ucl.ac.uk

Warwick, http://itunes.warwick.ac.uk

Oxford Web Podcasting portal, http://podcasts.ox.ac.uk

Trinity Dublin, http://www.tcd.ie/podcasts/

University of Westminster student photography 2006 podcast, http://feeds.feedburner.

com/londonphotocast

Warwick University podcasting, http://www2.warwick.ac.uk/newsandevents/audio/
University of Ulster podcasts, http://www.publicaffairs.ulster.ac.uk/podcasts/

Bath University public lecture podcasts, http://www.bath.ac.uk/podcast/
Education Podcast Network (EPN), http://epnweb.org/

Podcast Directory for Educations, http://recap.ltd.uk/podcasting/index.php

Projects

Steeple, http://www.steeple.org.uk

OpenCast, http://www.opencastproject.org

Steeple Podcast Portal, http://podcast.steeple.org.uk

PPP, Podcasting for Pedagogic Purposes - a UK community podcasting SIG, http://
podcastingforpp.pbwiki.com/

Impala Podcasting project based at Leicester - http://www?2.le.ac.uk/projects/impala/

Rights

Podcasting Legal Guide (Creative Commons), http://wiki.creativecommons.org/
Podcasting_Legal _Guide

Web2.0 Rights project, http://www.web2rights.org.uk/

University of Cambridge Streaming Media Service, http://www.cam.ac.uk/video/
contribute/smsfaqg.html

University of Cambridge consent forms, http://www.admin.cam.ac.uk/cam-only/
offices/communications/services/photoconsent/
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Articles

¢ Derek Morrison on Podcasts, http://www.bath.ac.uk/dacs/cdntl/pMachine/
morriblog_comments.php?id=381 0 4

¢ Podcasting briefing document, http://www.ukoln.ac.uk/ga-focus/documents/
briefings/briefing-83/

* Podcasts on Wikipedia, http://en.wikipedia.org/wiki/Podcast

¢ Bradford University using podcasts instead of normal lectures, http://news.bbc.co.uk/
1/hi/england/west_yorkshire/5013194.stm

* University of Southampton's School of Electronics and Computer Science has launched
the first video podcast news service from a UK university, http://www.electronicstalk.
com/news/unv/unv104.html

» Examples of podcasting in North American institutions, http://education.guardian.co.
uk/elearning/story/0,,1550197,00.html

» Stanford to offer course material available on iTunes, http://education.guardian.co.uk/
elearning/story/0,,1597970,00.html

Software

* Audacity, http://audacity.sourceforge.net/

* LAME MP3 Encoder, http://lame.sourceforge.net/

e iTunes, http://www.apple.com/itunes/

ProfCast (Macintosh only), http://www.profcast.com/

* ePodcast Producer (Windows only), http://www.industrialaudiosoftware.com/products/
epodcastproducer.html

e Podium (Windows only), http://www.podiumpodcasting.com/

* Apple Garageband, http://www.apple.com/software

Recording Hardware

» Fostex FR2 digital recorder, http://www.solidstatesound.co.uk/fostex_fr2-le.htm

* Marantz PMD660 portable digital recorder, http://www.solidstatesound.co.uk/
marantz_pmd660.htm

* Portable recorders (e.g. solid state digital recorders), http://www.hhb.co.uk/hhb/uk/
products/section.asp?section=Portable%20Recorders

e USB microphones (e.g. Samson CO1U USB mic), http://www.musictechmag.co.uk/
mtm/reviews/c0lu-usb-microphone

» Digital video cameras, http://reviews.cnet.com/Camcorders/2001-6500_7-0.html

¢ Audio mixing equipment (e.g. M-Audio’s NRV 10 FireWire Mixer), http://www.nextag.
com/audio-mixer/search-html

e iPod, www.apple.com/ipod/
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Educational video portals

The following are a small set of video/audio web portals, useful for reviewing and for
technical evaluation. The list is not trying to show all web pages that have HE video on it,
but we're trying to list typical video/audio web portals, that might be interesting for
gathering technical requirements for anyone considering similar work

Podcasting Portals in HE

* Oxford University: http://podcasts.ox.ac.uk/ (iTunesU launching page http://itunes.
ox.ac.uk/)

* Open University, http://podcast.open.ac.uk/, (iTunesU launching page http://www.
open.ac.uk/itunes/)

e CamTV http://mediaplayer.group.cam.ac.uk . Presents media across the whole
University in a single web portal, aggregating from the UCS-SMS (see next entry),
DSpace, YouTube, and other sources. A second instance of the mediaplayer is the
sciencelive site, http://www.sciencelive.org

e Cambridge UCS-SMS http://sms.cam.ac.uk/ presents media that has been processed
by the UCS-SMS service on the web.

* ARCA http://arca.rediris.es . Spanish national media portal, using the ARCA software

developed by Carlos III University.

Leeds http://lutube.leeds.ac.uk/
http://podcast.iu.edu/Portal/

* Princeton http://uc.princeton.edu/main/

MIT http://mitworld.mit.edu/ (For those familiar with the old MIT World portal: This is
now a flash-based site.)

For many of these projects, there are descriptions on the http://www.opencastproject.org
site.

AV Portal plugins

e http://filmforge.koumbit.net/en/about for Drupal

¢ MetaVid for mediawiki

* CamTV/Mediaplayer/ScienceLive plugin for Joomla.
e http://www.phpmotion.com/

e http://www.ostube.de/en/ostube

e http://blog.plumi.org/features/ for Plone (Zope).

The rest of this page is intentionally left blank for your own contributions! Please
contribute to these tutorials by visiting Steeple at http:// www. steeple. org. uk/
contribute"

Source: http://www.ict4e.net/wiki source/index.php?o0ldid=8111

Contributors: Bjoern, OLewis, PeterRobinson
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